# Table of Contents

1. **INTRODUCTION** ................................................................................................................................. 5

2. **SETUP** ................................................................................................................................................. 7
   2.1. **SYSTEM REQUIREMENTS** .............................................................................................................. 7
   2.2. **INSTALLATION** .............................................................................................................................. 7
   2.3. **ACTIVATION** .................................................................................................................................. 10
   2.4. **UNINSTALL** ..................................................................................................................................... 10

3. **CONTENT ASSEMBLY** ............................................................................................................................. 11
   3.1. **OVERVIEW** ..................................................................................................................................... 11
   3.2. **USING CONTENT ASSEMBLY** ......................................................................................................... 12
   3.3. **SPLITTING PDF FILES** .................................................................................................................. 13
       3.3.1. **Split into files of n pages** ...................................................................................................... 14
       3.3.2. **Split by page marks** ............................................................................................................ 15
       3.3.3. **Split by bookmarks** ............................................................................................................. 20
       3.3.4. **Split by page range** ............................................................................................................ 21
       3.3.5. **General splitting options** ................................................................................................... 23
       3.3.6. **Destination folder and filename settings** ........................................................................... 24
   3.4. **MERGING FILES** ........................................................................................................................... 25
       3.4.1. **Adding Files or Folders** ...................................................................................................... 26
       3.4.2. **Using a control file** ............................................................................................................. 27
       3.4.3. **Saving the merged file** ....................................................................................................... 30

4. **BOOKMARKS** ......................................................................................................................................... 31
   4.1. **OVERVIEW** ..................................................................................................................................... 31
   4.2. **USING BOOKMARKS** ..................................................................................................................... 32
       4.2.1. **Bookmark Features** ............................................................................................................. 32
   4.3. **ADDING BOOKMARKS** ................................................................................................................. 35
       4.3.1. **The Preview Pane** .............................................................................................................. 35
       4.3.2. **Add Bookmarks to PDF** ..................................................................................................... 41
       4.3.3. **Importing/Exporting Bookmark Settings** ........................................................................... 41
   4.4. **FINDING AND REPLACING BOOKMARKS** ..................................................................................... 44
       4.4.1. **Find Options** ....................................................................................................................... 45
       4.4.2. **Replace Options** .................................................................................................................. 45
       4.4.3. **Using Text Masking** .......................................................................................................... 46
   4.5. **BUILDING BOOKMARKS** ............................................................................................................... 47
       4.5.1. **Creating Bookmarks** ......................................................................................................... 49
       4.5.2. **Creating Bookmark Every nth page** ................................................................................ 49
       4.5.3. **Importing/Exporting Bookmark Build Options** .................................................................. 50
       4.5.4. **Bookmark Selection Properties** ..................................................................................... 50
   4.6. **DELETING BOOKMARKS** .............................................................................................................. 47
   4.7. **SORTING BOOKMARKS** ............................................................................................................... 63
## Contents

6.4. **LINK MANAGEMENT** ................................................................................................................................................................ 92

6.3. **EXPORT/IMPORT LINKS** .......................................................................................................................................................... 89

6.1. **OVERVIEW** ................................................................................................................................................................................. 88

5.7. **CONFIGURING STAMP PREFERENCES** .................................................................................................................................... 87

5.6. **LOGGING** ..................................................................................................................................................................................... 85

5.5. **DESIGNING STAMPS** ................................................................................................................................................................. 73

5.2. **MAIN FEATURES** ....................................................................................................................................................................... 65

5.1. **OVERVIEW** ................................................................................................................................................................................. 64

4.8. **INSERT DESTINATION OFFSET** ......................................................................................................................................................... 60

## 5. **STAMP** ......................................................................................................................................................................................... 63

5.4. **MANAGING STAMPS AND PROFILES** .......................................................................................................................................... 69

5.3. **USING STAMPS** .......................................................................................................................................................................... 67

5.2. **MAIN FEATURES** ....................................................................................................................................................................... 65

5.1. **OVERVIEW** ................................................................................................................................................................................. 64

5.4.1. **Creating a new Profile** .......................................................................................................................................................... 70

5.4.2. **Creating a new Stamp** ....................................................................................................................................................... 70

5.4.3. **Previewing a Profile/Stamps** .............................................................................................................................................. 70

5.4.4. **Renaming Profiles/Stamps** ............................................................................................................................................. 70

5.4.5. **Deleting Profiles/Stamps** .................................................................................................................................................. 71

5.4.6. **Rearranging Stamps** .......................................................................................................................................................... 71

5.4.7. **Importing/Exporting Profiles** ........................................................................................................................................ 71

5.4.8. **Editing Stamps** ................................................................................................................................................................. 72

5.4.9. **Right Click Menus** ............................................................................................................................................................ 72

5.5. **DESIGNING STAMPS** ................................................................................................................................................................. 73

5.5.1. **General Stamp Settings** .................................................................................................................................................... 73

5.5.2. **Text Stamp Properties** ................................................................................................................................................... 77

5.5.3. **Image/PDF Stamp Settings** .......................................................................................................................................... 83

5.6. **LOGGING** ..................................................................................................................................................................................... 85

5.6.1. **View Log File** ................................................................................................................................................................. 85

5.6.2. **Clear Log File** .............................................................................................................................................................. 86

5.7. **CONFIGURING STAMP PREFERENCES** .......................................................................................................................................... 87

5.7.1. **File Handling** ................................................................................................................................................................. 87

5.7.2. **Defaults** ............................................................................................................................................................................ 87

6. **LINKS** ............................................................................................................................................................................................. 88

6.1. **OVERVIEW** ................................................................................................................................................................................. 88

6.2. **USING LINKS** ............................................................................................................................................................................. 89

6.3. **EXPORT/IMPORT LINKS** .......................................................................................................................................................... 89

6.3.1. **Export Links** ................................................................................................................................................................. 89

6.3.2. **Import Links** ................................................................................................................................................................. 90

6.4. **LINK MANAGEMENT** ............................................................................................................................................................... 91

6.3.3. **Show Dead Link Toolbar** .................................................................................................................................................. 91

6.3.4. **Find Next Dead Link** ...................................................................................................................................................... 91

6.3.5. **Find Previous Dead Link** .............................................................................................................................................. 91

6.3.6. **Find Dead Links On This Page** .................................................................................................................................... 91

6.4.1. **Show/Hide Link Alignment Palette** .................................................................................................................................... 92

6.4.2. **Set Link(s) Properties** ................................................................................................................................................... 93
### Contents

**6.4.3.** Find And Replace Destinations .......................................................... 95  
**6.4.4.** Set Base URL ......................................................................................... 98  
**6.4.5.** Create Page Links ................................................................................ 99  
**6.4.6.** Create Keyword Links .......................................................................... 101  
**6.4.7.** Table of Contents ................................................................................ 104  
**6.5.** Delete Links ............................................................................................. 110  
**6.6.** Reporting ................................................................................................... 111  
  
**6.6.1.** Report on Bad Actions .......................................................................... 111  
**6.6.2.** Report on Bad Bookmarks ..................................................................... 112  
**6.6.3.** Report on All Links ............................................................................... 113  
**6.6.4.** Report on External Dependencies ........................................................ 114  
**6.6.5.** Report on Selected Link ........................................................................ 115  
**6.6.6.** Count Links ........................................................................................... 117  
**6.7.** Configuring Link Preferences .................................................................. 118  
**6.8.** Additional Link Features .......................................................................... 120  
  
**6.8.1.** Multiple – select and drag links ............................................................. 120  
**6.8.2.** Cut and paste links ............................................................................... 121  
**6.8.3.** Paste links onto multiple pages or multiple files .................................... 122  

**7.** Imposition ..................................................................................................... 123  
**7.1.** Imposition Layout .................................................................................... 123  
  
**7.1.1.** Horizontal/Vertical copies ...................................................................... 123  
**7.1.2.** N-Up ...................................................................................................... 124  
**7.1.3.** Step and Repeat .................................................................................... 124  
**7.1.4.** Add crop and registration marks ............................................................ 124  
**7.1.5.** Add gutter ............................................................................................. 124  

**8.** Mail Merge .................................................................................................. 125  
**8.1.** Overview .................................................................................................. 125  
**8.2.** Using Mail Merge ..................................................................................... 126  
  
**8.2.1.** Data Source Options ............................................................................. 126  
**8.2.2.** PDF Output .......................................................................................... 126  
**8.2.3.** Advanced Options .............................................................................. 126  

**9.** Troubleshooting .......................................................................................... 128  
**9.1.** Frequently Asked Questions ................................................................... 128  
**9.2.** Forum ...................................................................................................... 133  
**9.3.** Known Issues ......................................................................................... 133  
**9.4.** Updates ................................................................................................... 134  
**9.5.** Premium Upgrade Protection ................................................................. 134  
**9.6.** Technical Support ................................................................................... 135  

**10.** Index ........................................................................................................ 136
Debenu PDF Aerialist™ takes Acrobat to the next level with its advanced tools for bookmarks, links, table of contents (TOC) generation, splitting, merging and stamping. Suitable for government agencies and industries - including pharmaceutical, legal, finance, IT and publishing - Debenu PDF Aerialist™ helps users efficiently prepare electronic documents for exchange, archives, submission and publishing.

Debenu PDF Aerialist™ comprises features from the following functional groups:

- **Table of Contents (TOC)** – Generate table of contents (TOC) automatically from bookmarks, headings, files, etc.

- **Bookmarks** – Make PDF documents more usable and easier to navigate. Add, edit, build, replace and delete bookmarks across one or more PDF documents.

- **Links** – Edit and update multiple links and their properties in batch; automate the painstaking task of auditing links for validity; examine all links and bookmarks between documents, to named destinations and to Web pages.

- **Content Assembly** – Split, merge and append pages and whole documents to create new PDFs; split documents based on page groups, page ranges, bookmarks and page marks; use merge functionality to sort and combine large PDF document collections.

- **Stamps** – Insert PDF, text and image stamps, watermarks and overlays -- Add page and bates numbering; add headers and footers.

- **Imposition** – N-up, Step & Repeat, 2-Up Booklet, 4-Up Booklet.

- **Mail Merge** – Merge data from spreadsheets or text files into PDF form template and save the output a unique PDF file.

Debenu PDF Aerialist™ toolbar
Note: This document contains information on both the Mac and Windows ® versions of Debenu PDF Aerialist. Wherever appropriate, the differences are clearly indicated. This document specifically covers the features in Debenu PDF Aerialist™ version 12.
2.1. System Requirements

Windows

- 1.3GHz or faster processor
- Microsoft® Windows® XP Home, Professional, or Tablet PC Edition with Service Pack 3 (32 bit and 64 bit); Windows Server® 2003 (32 bit and 64 bit; Service Pack 2 required for 64 bit); Windows Server 2008 or 2008 R2 (32 bit and 64 bit); Windows Vista® Home Basic or Premium, Business, Ultimate, or Enterprise with Service Pack 2 (32 bit and 64 bit); Windows 7 Starter, Home Premium, Professional, Ultimate, or Enterprise (32 bit and 64 bit)
- 512MB of RAM (1GB recommended); Windows 8, Pro, or Enterprise.
- Note: For Windows Server 2003 SP2, Microsoft Update KB930627 is required.
- Adobe® Acrobat® version 9.0 or later.

Macintosh

- Intel® processor
- Mac OS X v10.5.x to v10.10.x
- 512MB of RAM (1GB recommended)
- Adobe® Acrobat® version 9.0 or later.

Note: Batch processing is only supported in the Professional version of Adobe® Acrobat®.

For technical support queries, please consult the Troubleshooting section of this manual or email support@debenu.com

2.2. Installation

You may have received this software on either CD-ROM or as a downloaded file.

Macintosh

To install from a CD-ROM:

1. Verify that Adobe Acrobat is not running.
2. Insert the CD-ROM.
3. Open the CD and double click the Install file.
4. Navigate to Debenu PDF Aerialist™.
5. Click install.
6. Follow the prompts to install Debenu PDF Aerialist™.

If you downloaded Debenu PDF Aerialist™, to install:

1. Verify that Adobe Acrobat is not running.
2. Decompress the distribution file provided.
3. Execute the installation file.
4. Follow the prompts to install Debenu PDF Aerialist™.

Windows

Please note: Administrator privileges are required to install Debenu PDF Aerialist on Windows Vista and later versions of Windows. If you attempt to install using an account without Administrator privileges you will be prompted for Administrator login details during the installation process.

If you downloaded Debenu PDF Aerialist™ as an executable (.exe), to install:

1. Verify that Adobe Acrobat is not running.
2. Execute the installation file provided.
3. Follow the prompts to install Debenu PDF Aerialist™. Read the “Installer Options” information below about installing for All Users or Current User.

To install from a CD-ROM:

1. Verify that Adobe Acrobat is not running.
2. Insert the CD-ROM.
3. If the CD-ROM does not automatically start, navigate to the CD in Windows Explorer and execute the Windows Installer.exe file.
4. Navigate to Debenu PDF Aerialist™.
5. Click Install.
6. Follow the prompts to install Debenu PDF Aerialist™.

Installer Options

The Windows installer for Debenu PDF Aerialist gives you two installation options:

1. **Install for anyone using this computer**: installs for all user accounts on that installation of the Windows operating system. Anyone with a valid account can login and use the software.
2. **Install for just me**: installs only for the user who is installing the software.
2.3. Registration

If you have the demo version of Debenu PDF Aerialist™ installed, register the full version using the following steps:

1. In Acrobat select ‘Help > About Third-Party Plug-Ins > Debenu PDF Aerialist™.
2. Ensure you have a valid version 12 license key. If you do not already have a version 12 license key you can purchase one through the Debenu (www.debenu.com) website.
3. Select the ‘License Information’ tab page and click on ‘Register License Key’.
4. Enter your license details (If you do not have a company name enter NA), including your license key, and click "OK".
2.4. Uninstall

**Mac**

To uninstall on a Mac platform:

1. Make sure that Adobe Acrobat is not open
2. Go to the “Applications” folder in “Finder”
3. Double-click on the “Adobe Acrobat” folder name
4. Right-click on the “Adobe Acrobat Pro.app” file and select “Show Package Contents” from the context-menu
5. Double-click on the “Contents” folder and then double-click on the “Plug-ins” folder
6. Select the plug-in (e.g. *DebenuAerialist.acroplugin*) that you want to remove and drag it into the “Trash” to uninstall

**Windows**

To uninstall on a Windows platform:

1. Verify that Adobe Acrobat is not running
2. Open the “Control Panel” (Start > Control Panel)
3. Open “Uninstall a program”
4. Select “Debenu PDF Aerialist” from the menu.
5. Click “Uninstall”.
3.1. Overview

The Content Assembly feature is for splitting and merging batches of PDF files. The split functionality lets you split one or more PDF files based on page groups, page ranges, bookmarks and page marks. The merge functionality lets you quickly sort and then combine a collection of files into a PDF document.

Features

- Split into files of $n$ pages - split into files containing $n$ pages per file
- Split by page marks - visually highlight sections of a PDF to split
- Split by bookmarks - split files based on bookmark hierarchy
- Split by page ranges - split individual pages and page ranges
- Advanced splitting - odd and even, complex file naming, updating bookmarks, links and named destinations
- Merge files - merge files or folders of PDF files together into a single file
3.2. Using Content Assembly

Content Assembly consists of a collection of splitting methods and one merging function: Split into files of n pages, Split by page marks, Split by bookmarks, Split by page range, and Merge files/folder.

The Content Assembly toolbar buttons

The Content Assembly menu
3.3. Splitting PDF files

The Content Assembly feature offers a rich set of methods for extracting pages from a PDF file to separate files.

- Split into files of $n$ pages – split into files containing $n$ pages per file
- Split by page marks – visually highlight sections of a PDF to split
- Split by bookmarks – split files based on bookmark hierarchy
- Split by page ranges – split individual pages and page ranges
- Advanced splitting - odd and even, complex file naming, updating bookmarks, links and named destinations

![Split File window](image)
3.3.1. **Split into files of n pages**

This method splits the open PDF document into a series of files, which contain ‘n’ pages in each file.

To split into ‘n’ pages:

1. Select and open the source PDF file to be split.
2. Select ‘Split PDF Into files of’ by checking on the radio button.
3. Enter the number of pages in which to split the PDF file.
4. Select the destination folder where the PDF files will be stored following splitting. This can be set to the same as the source folder, or in the folder of the user’s choice.
5. Enter the base filename and the destination folder. The base filename will be used as a starting point in the file name of the resulting output.
6. Click ‘Split’ to start processing.
3.3.2. **Split by page marks**

Using the Add Page Marks feature, add a page mark to pages in the document. Each page mark indicates the start of a new file when the document is split. When splitting by page marks, all subsequent pages will be added to the new PDF until the next page mark or the end of the file is reached.

Page marks are added using the Add/Edit Page Mark feature.

- **By page marks**
- **page mark contains full path & filename**

### Split by page mark

To split by page marks:

1. Select and open the source PDF file to be split.
2. Verify that the PDF to be split has page mark/s.
3. Select ‘By page marks’ as the method of splitting.
4. Select the destination folder where the PDF files will be stored following splitting. This can be set to the same as the source folder, or in the folder of the user’s choice.
5. Click the ‘Split’ button to start processing.

**Note:** if you have specified the full path and filename within the page mark, rather than just a filename, then you need to check the option ‘page mark contains full path/filename’. This will ignore the destination folder settings and use the path stored within the page mark for saving the target PDF file.
3.3.2.1. Adding page marks

To add a Page Mark:

1. Choose 'Plug Ins > Debenu PDF Aerialist™ > Content Assembly > Add / Edit Page Mark” from Acrobat’s Plug-ins menu.
2. Alternatively use the Add / Edit Page Mark button from the Debenu PDF Aerialist™ toolbar.
3. The ‘Mark Page’ dialog opens. This contains properties of the page mark. These include:
   - File Name (of the document)
   - Title
   - Subject
   - Author
   - Keywords

The document information fields (metadata) will be applied to the resulting PDF file.
3.3.2.2. **Removing page marks**

To remove all of the page marks within a document:

1. Choose ‘Plug Ins > Debenu PDF Aerialist™ > Content Assembly > Remove Marks’ from Acrobat’s Plug-ins menu.
2. Alternatively click on the Remove Marks tool in the Debenu PDF Aerialist™ toolbar.
3. This prompts to confirm if the page marks should be removed. Also there is a warning that this action cannot be undone.
4. Clicking ‘OK’ removes the page marks on the PDF.
5. Clicking ‘Cancel’ returns to the document without removing the page marks.
### 3.3.2.3. Viewing / editing page marks

To view and edit a list of all marked pages within a document:

1. Choose 'Plug Ins > Debenu PDF Aerialist™ > Content Assembly > View/Edit Marks' from the Acrobat menu.
2. Alternatively check on the View/Edit Marks button from the Debenu PDF Aerialist™ toolbar.
3. Edit a Page Mark
   a. Highlight the page mark you want to edit by checking on the page mark in the dialog box as shown below.
   b. Click on ‘Edit’
   c. The ‘Mark Page’ dialog opens. Users can then modify the properties.
4. A list of Page Marks can be viewed / edited and removed.

![View/Edit Page Marks dialog](image-url)
3.3.2.4. **Exporting page marks**

This feature allows you to export page mark information into a tab delimited text file. You can store the text file and apply your page mark settings onto a PDF document by exporting the file.

The tab delimited file logs information for all the page marks present in the document. The data logged in the text file includes:

- **Page Number**: The page number of the start of the fragment.
- **File name**: The name that the file fragment is to be called.
- **Title**: The title of the new file fragment.
- **Subject**: The subject of the new fragment
- **Author**: The author of the document
- **Keywords**: Any keywords for the new file fragment.

The format of the tab delimited text file is:

```
Keywords [enter]
```

3.3.2.5. **Import page marks**

This feature allows you to import page marks from a tab delimited text file\(^1\) to your PDF document. Importing a tab delimited text file containing page mark information will apply page marks to your PDF to prepare for splitting. Importing page marks will enable you to apply your page mark settings at a later stage or on other PDF documents.

---

\(^1\) A tab delimited text file can be created by the Exporting page marks feature.
3.3.3. **Split by bookmarks**

This method will split a PDF file by its bookmarks. Each page that is bookmarked will be the start of a new PDF, and the title of the bookmark will be used as the name of the file.

All subsequent pages will be added to the new PDF stopping at the next bookmarked page. You will be given a chance to choose the level of bookmarks to use in the Split function.

![Split by bookmarks](image)

To split by bookmarks:

1. Select and open the source PDF file to be split.
2. Verify that the PDF to be split has bookmarks.
3. Select ‘By bookmarks starting at Level’ as the method of splitting.
4. Browse for the destination folder where the PDF files will be stored following splitting. This can be set to the same as the source folder, or in the folder of the users choice.
5. Click the ‘Split’ button to initiate processing.
3.3.4. **Split by page range**

This method of splitting will split a PDF file into smaller PDF files containing one or more pages in the destination folder specified by the user.

![Split by page range](image)

To split by page range:

1. Select and open the source PDF file to be split.
2. Select Split PDF 'by page range'.
3. Select the destination folder where the PDF files will be stored following splitting. This can be set to the same as the source folder, or in the folder of the user’s choice.
4. Enter the page ranges you wish to split into each file. Page ranges should be separated by commas and semicolon used to separate files. See the table following for detailed instructions.
5. Enter the base filename for the split process, and then specify the destination to save the files to. The base filename will be appended to the resulting smaller PDF files after the split process.
6. Click the 'Split' button to initiate processing.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Semicolon) “;”</td>
<td>File separator</td>
<td>“1-20; 21-40” would create two new PDFs – one containing pages 1-20, the other containing pages 21-40.</td>
</tr>
<tr>
<td>(Hyphen) “-”</td>
<td>From/To</td>
<td>“1-5” would extract pages 1 through 5 into a new PDF. “5-1” would extract pages 5 through 1 into a new PDF <em>(reverse order is + only)</em>.</td>
</tr>
<tr>
<td>(Comma) “,”</td>
<td>Page separator</td>
<td>“1-20, 30-40” would create a single PDF containing page 1-20 and 30-40.</td>
</tr>
<tr>
<td>“odd” (+ only)</td>
<td>Odd page</td>
<td>“1-20 odd” would create a single PDF containing only the odd pages within the range of 1-20.</td>
</tr>
<tr>
<td>“even” (+ only)</td>
<td>Even page</td>
<td>“1-20 even” would create a single PDF containing only the even pages within the range of 1-20.</td>
</tr>
</tbody>
</table>

An example string is shown below, inverted commas (““) are for demonstration purposes only:

“1-20 odd, 21-40 even, 41-45, 50; 50, 45-41, 40-21 even, 20-1 odd”

The example string would perform the following:

1. Create one PDF containing the following (in this order):
   - All odd pages from 1-20.
   - All even pages from 21-40.
   - Pages 41-45.
   - Page 50.

2. Create a second PDF containing the following (in this order):
   - Page 50.
   - Pages 45-41 (reverse order).
   - All even pages from 40-21 (reverse order).
   - All odd pages from 20-1 (reverse order).
3.3.5. General splitting options

2. Set General Options

- Enable Fast Web View
- Update Navigational Elements
- Show Progress Report (Slow)
- Support identical form fields (Slow)
- Update title using output filename

General Options

Enable Fast Web View
Restructures the PDF file so that it can be served page-at-a-time over the Web. This is referred to as Fast Web View within Adobe Acrobat.

Update Navigational Elements
This is a Plus only feature that updates all of the bookmarks, links and named destinations such that they remain connected to the proper page.

GoTo links, which are links within the document, are adjusted to stay connected to the proper page, even if the pages end up in a different order in the final document. If pages are arranged such that the page linked from ends up in a different file than the page linked to, the GoTo link is changed into a GoToR link, which is a link that goes from one file to another.

GoToR links and Launch actions, both of which reference an external file, that use a relative pathname will be adjusted to take into account the difference if the files created by splitting are in a different directory from the original file. If you split a file with named destinations, the named destinations will be inserted into the files and each adjusted to continue pointing to the correct page.

Links that use named destinations within the original document will be changed from GoTo to GoToR links as necessary if source and destination end up in different files. The links will still use named destinations. Bookmarks are copied into all files and are adjusted just as the links are.

Show Progress Report
This is a Plus only feature that, when selected, will show a description of the split process in the Acrobat status bar. Users may find that this will make the split process run slower but it will give a description on the status of each stage of the splitting process.

Support identical form field
Inserts pages into the target files, page-at-a-time. Whilst this is much slower, it will ensure that PDF files that contain form fields with identical names will still function correct.
Update title using output filename
Uses the filename (without the .pdf extension) as the document information’s title for all output files.

Bookmarks
After processing, the following options can be applied to bookmarks within the target files:
  • Expand all
  • Collapse all
  • Expand local
    This advanced option will expand the bookmarks that link to pages within each split file.
  • Do not change

3.3.6. Destination folder and filename settings

The filename for the files resulting from the split is constructed by adding a changing suffix to a specified base filename.

The base filename can be specified in the Base filename edit box or derived from each file dynamically by selecting the “Use filename” checkbox. You would normally select this option during Batch Processing.

The target filename additions are as follows:
  • A number – a number which is incremented for each new file
  • A padded number starting at – an incrementing number padded with leading zeroes. You can specify a starting point for the number or padded number options in the box labeled Number, following the target filename combo box.
  • The page range (pxx-pyy) – the start and end page of the pages from the original document.
  • A letter – an incrementing letter (eg. A-Z, AA-ZZ, etc...)
  • Nothing – used in splitting by bookmarks or page marks where the base filename changes for each file.

The files are saved in the folder specified in the Destination Folder box or the source folder, if that option is selected.
3.4. Merging Files

The Merge function allows you to merge a set of files together into a single PDF document. You can select either all pages, or a page range from a document you wish to merge, as well as reordering the files as required. It supports a number of file types:

- Adobe PDF Files (*.pdf)
- AutoCAD (*.dwg, *.dwt)
- BMP (*.bmp, *.rle, *.dib)
- Compuserve GIF (*.gif)
- JPEG (*jpg, *jpeg, *.jpe)
- Microsoft Excel (*.xls)
- Microsoft PowerPoint (*.ppt)
- Microsoft Project (*.mpp)
- Microsoft Visio (*.vsd)
- Microsoft Word (*.doc, *.rtf)
- PCX (*.pcx)
- PNG (*.png)
- PostScript/EPS (*.ps, *.eps)
- TIFF (*.tif, *.tiff)
3.4.1. Adding Files or Folders

To add files or folders and merge the files into one PDF document:

1. Choose ‘Plug-Ins > Debenu PDF Aerialist™ > Content Assembly > Merge Files’ from Acrobat’s Plug-in menu.
2. Alternatively select the ‘Merge File’ tool from the Debenu PDF Aerialist™ toolbar.
3. Browse and add the files that you want to merge.
   - Click “Add Files”, from the ‘Merge Files’ dialog to open the browser window and select the files that have to be merged.
   - The Merge Options dialog will open allowing you to enter a specific page range for the selected file. See below for more information on the Merge Options.
4. Additionally, you can browse and add a folder containing files that you want to merge.
   - Click “Add folder” from the Merge Files dialog to open the browse for folder dialog. Only one folder can be selected at a time and all files within the folder (of supported file types) will be added.
   - A complete list of the selected files will be displayed in the Merge dialog. Selecting a file and clicking ‘Edit’ can modify the Merge Options. See below for more information on the Merge Options.
5. Change the order in which the files are going to be merged.
   - Click on “Move Up” and “Move Down” buttons to alter the position of the files in the merge list.
6. Click “Merge”.

3.4.1.1. Merge Options

The Merge Options dialog allows you to specify the pages of the file you want added to the final merged file. You can set which pages to merge by selecting a predefined range:

- All pages
- Odd pages
- Even pages
- Last page
- First page

Alternatively, you can define the pages (using hyphens and commas to separate the pages) i.e. 2, 6, 10-20; or by page range from page 1 to 6 for example.

The ‘Validate page range’ option is only used for files that are not of an Adobe Acrobat file type (*.pdf). If selected, the Merge function will convert the file prior to merging it and will determine whether the page range entered is valid. If not selected, the page range will not be validated and if an error occurs during the merge process it will be stopped. Once the Merge function knows the page range of the file (i.e. the number of pages within the file is known) this option will be disabled. It is recommended that, when possible, always have this option selected to ensure that no out of range errors occur during the merge process.

3.4.2. Using a control file

A control file lets you perform multiple merging of PDF documents in one process. Using a control file you can specify the output filename and the pages to be copied from other
PDF documents into the merged file. A control file is simply a text file detailing the output filename and files to be used in the merge process.

To use a control file:

1. Click on the ‘Merge files’ button from the Debenu PDF Aerialist™ toolbar or select ‘Plug-Ins > Debenu PDF Aerialist™ > Content Assembly > Merge Files’ from Acrobat’s Plug-in menu.
2. In the Merge files dialog, click on the “Control files” button.
3. Navigate to the desired control file (*.txt) and click “Open”.
4. A message in the ‘Merge files’ list box will appear. When you are ready to start the process click “Merge”.

The structure of a merge within a control file is shown below. Merging a range of pages from a file:

```
-f [full pathname of the output merge file] [page range] [tab] [full pathname of the source file]
```

Note: the ‘-f’ switch will start a new merge file and you can add an unlimited amount of pages to the file.

Merging all pages from a file:

```
-f [full pathname of the output merge file] [full pathname of the source file]
```

For the [page range] the following can be entered:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Function</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Hyphen) “-”</td>
<td>From/To</td>
<td>“1-5” would extract pages 1 through 5 into a new PDF.</td>
</tr>
<tr>
<td>(Comma) “,”</td>
<td>Page separator</td>
<td>“1-20, 30-40” would merge pages 1-20 and 30-40.</td>
</tr>
<tr>
<td>“odd”</td>
<td>Odd page</td>
<td>“1-20 odd” would create a single PDF containing only the odd pages within the range of 1-20.</td>
</tr>
<tr>
<td>“even”</td>
<td>Even page</td>
<td>“1-20 even” would create a single PDF containing only the even pages within the range of 1-20.</td>
</tr>
</tbody>
</table>

For example:

[page range] entered is: “1-20 odd, 21-40 even, 41-45, 50”
Pages from the source file to go in the merge file will be
  • All odd pages from 1-20
  • All even pages from 21-40
  • Pages 41-45
  • Page 50

[page range] entered is: “50, 45-41, 40-21 even, 20-1 odd”

Pages from the source file to go in the merge file will be
  • Page 50
  • Pages 45-41 (reverse order)
  • All even pages from 40-21 (reverse order)
  • All odd pages from 20-1(reverse order)

Examples of a Control File

Content of a control file specifying the page range:

```plaintext
-mf C:\Sample Files\Output\Merge.pdf
1-10,15,18 C:\Sample Files\File1.pdf
C:\Sample Files\File2.pdf
1-20 odd C:\Sample Files\File3.pdf
odd C:\Sample Files\File4.pdf
```

Result is output file 'Merge.pdf' containing
  • Only pages 1 to 10, page 15 and page 18 of File1.pdf
  • All pages of File2.pdf
  • Only the odd pages from page 1 to 20 of File3.pdf
  • Only odd pages of File4.pdf

Content of a control file where all pages from a file is merged:

```plaintext
-mf C:\MyDocuments\Invoice2xx.pdf
C:\MyDocuments\Invoice234.pdf
C:\MyDocuments\Invoice246.pdf
-mf C:\MyDocuments\Invoice3xx.pdf
C:\MyDocuments\Invoice354.pdf
C:\MyDocuments\Invoice321.pdf
-mf C:\MyDocuments\Invoice4xx.pdf
C:\MyDocuments\Invoice478.pdf
```

Result is output file 'Invoice2xx.pdf' containing
  • All pages of Invoice234.pdf
  • All pages of Invoice 246.pdf
An output file 'Invoice3xx.pdf’ containing
  • All pages of Invoice354.pdf
  • All pages of Invoice321.pdf
And output file ‘Invoice4xx.pdf’ containing
  • All pages of Invoice478.pdf
3.4.3. **Saving the merged file**

Once you have merged the files into a single PDF, to save the merged file for later use, follow these steps:

1. Click on File > Save As.
2. Select the directory path where you want to save the merged PDF file.
3. Enter a filename.
4. Click on Save to initiate saving of the merged PDF file.
4.1. **Overview**

The Bookmarks feature set provides the ability to add, audit, edit, build, replace, delete and sort bookmarks across one or more PDF files. The tool allows users make almost any PDF file more usable and easier to navigate.

The Bookmarks feature set has been built to save time creating and managing bookmarks. By allowing users to import and export build settings, bookmark trees and by providing batch processing functionality, users can process and update large collections of PDFs with a minimum of time and effort. Additionally, it has been engineered to work with the Productivity feature set, making it even easier to quickly access and run commonly used bookmark processes.
4.2. Using Bookmarks

There are four main Bookmark functions: Add Bookmarks, Find Bookmarks, Build Bookmarks, Delete Bookmarks and Sort Bookmarks.

4.2.1. Bookmark Features

A brief rundown of each function has been provided below.

All these functions can be automatically performed across multiple documents using Batch Processing. See the Batch Processing section for more information.
If you wish to automate and customize Bookmark functions even more, or create toolbar buttons that perform custom Bookmark jobs, read the section on Using Bookmark Commands.

4.2.1.1. Add Bookmarks

Use the Add Bookmarks feature to create a set of user-defined bookmarks; save your set of bookmarks using the Import/Export functionality so you can reuse them in batch processes.

4.2.1.2. Find Bookmarks

Use the Find Bookmarks feature to delete or replace only the bookmarks that match the search criteria you specify; once you have entered the content to search for, Find Bookmarks scans the bookmark text of all of the PDF files you have selected and updates them based on the text and properties changes you have specified.

4.2.1.3. Delete Bookmarks

Delete Bookmarks allows the user to simply delete all the bookmarks contained in the selected PDF file(s). This is a much easier way than having to manually highlight all of the bookmarks and then delete them – especially if you need to do this across multiple files.

4.2.1.4. Build Bookmarks

Use the Build Bookmarks feature to automatically generate bookmarks based on the font styles and layout used in your PDFs. After setting the desired combination of attributes for a bookmark to be generated, the Bookmark feature can quickly scan one or more PDF files to build the bookmarks for each document. Additionally, you can save your Build Bookmarks settings by using the Import/Export functionality so you can reuse them to process large collections of PDF files.

4.2.1.5. Page Bookmarks

Generating bookmarks every Nth page enables users to create a bookmark from every Nth page. Where N is number set by user. There are two practical uses for this. For example, if a user opens a 20-page document and set the N to 4, then bookmarks will be created for pages 4, 8, 12, 16 and 20.

4.2.1.6. Sort Bookmarks

The Sort Bookmarks feature automatically rearranges bookmarks in alphabetical order. It has the flexibility to order all bookmarks or a selected range of bookmarks in ascending or descending order.

4.2.1.7. Edit All Properties
The Edit All Properties feature lets you edit all bookmark properties for the current PDF. Change the appearance, style and magnification of bookmarks as well as actions. Modify all bookmark levels or only a specific bookmark level.

4.2.1.8. **Insert Destination Offset**

The Insert Destination Offset feature is for documents with broken bookmarks as a result of missing or new pages. Debenu PDF Aerialist fixes broken bookmarks by inserting a destination offset for the affected number of pages from a specified bookmark downwards.

4.2.1.9. **Bind Documents**

The Bind Documents feature lets you interlink PDFs by automatically generating a set of bookmarks based on the folder and file names of the selected root folder. The set of bookmarks is then applied to each file separately in the root folder or alternatively all the PDFs are merged into one PDF and the set of bookmarks is applied to it.

4.2.1.10. **Collapse and Expand Bookmarks**

The Collapse/Expand Bookmarks feature lets you collapse and expand all bookmarks in the current PDF. Change all bookmark levels or only specific levels.
4.3. Adding Bookmarks

The Add Bookmarks function creates a set of user-defined bookmarks. Use the Import/Export features to save and reuse a set of bookmarks in other documents using batch processes or with the Productivity feature.

4.3.1. The Preview Pane

The preview pane allows you to view and easily edit a bookmark structure. The bookmark structure can then added to any PDF document.

Add Bookmarks Preview Pane
4.3.1.1. **Add or Edit Bookmarks**

To create or edit a bookmark in the Add Bookmark’s preview pane:

1. Click ‘Add’ or ‘Edit’ to open the ‘New Bookmark’ dialog.
2. In the ‘New Bookmark’ dialog, enter the name and bookmark properties you wish the bookmark to have.
3. Click ‘OK’.

Details of bookmark properties can be in the next section, **Bookmark Properties**.

4.3.1.2. **Bookmark Properties**

Bookmark properties can be viewed when adding or editing a bookmark in the preview pane. The following table shows the properties that bookmarks can have.

<table>
<thead>
<tr>
<th><strong>Name</strong></th>
<th>The bookmark’s name that will appear in the document.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
<td>The bookmark’s font color. You can create and use custom colors by scrolling down the available list of colors, selecting &quot;Custom&quot; and creating your custom color from the ‘Custom Color’ dialog.</td>
</tr>
<tr>
<td><strong>Style</strong></td>
<td>Font style can be bold and/or italic.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>None</td>
<td>Nothing occurs when the bookmark is clicked.</td>
</tr>
<tr>
<td>Go To View</td>
<td>This action will jump to the specified page in the document. Various page magnification options are also available; see <a href="#">Magnification Options</a>.</td>
</tr>
<tr>
<td>Go To Remote View</td>
<td>This opens a specified PDF document at the designated page. Various page magnification options are also available; see <a href="#">Magnification Options</a>.</td>
</tr>
<tr>
<td>Open File</td>
<td>Opens the specified file. This file can be of any type, but only files with a *.pdf extension will be opened in Acrobat; all other file types will be opened in their default viewers.</td>
</tr>
<tr>
<td>WWW Link</td>
<td>Clicking on the bookmark opens a web browser to the URL specified within the WWW Link textbox.</td>
</tr>
<tr>
<td>Read Article</td>
<td>Selecting this action will link or display the bookmark to an article thread in the active document.</td>
</tr>
<tr>
<td>Show / Hide Field</td>
<td>Provides the option of either showing or hiding fields in a PDF document.</td>
</tr>
<tr>
<td>Submit Form</td>
<td>This will send the form data to a specified URL.</td>
</tr>
<tr>
<td>Reset Form</td>
<td>Resets all form fields to their original default value.</td>
</tr>
<tr>
<td>Import Form Data</td>
<td>Imports in form data from another file and displays it in the active form.</td>
</tr>
<tr>
<td>JavaScript</td>
<td>This option will run a specified JavaScript.</td>
</tr>
<tr>
<td>Execute Menu Item</td>
<td>Executes a specified menu command as the action when the bookmark is clicked.</td>
</tr>
<tr>
<td>Movie</td>
<td>Plays a specified QuickTime or AVI movie.</td>
</tr>
<tr>
<td>Sound</td>
<td>Plays a specified sound file.</td>
</tr>
</tbody>
</table>
Magnification Options:

This option is available in the action bookmark properties ‘Go To View’ and ‘Go To Remote View’. The option is also available when building bookmarks using the Build Bookmarks feature.

The following magnification options are available:

- **Inherit Zoom**
  Displays the destination window at the magnification level that the user is using when they click on the bookmark.

- **Zoom**
  Displays the page at a magnification specified by the user.

- **Fit Width**
  Displays the width of the current page in the destination window.

- **Fit Height**
  Displays the height of the current page in the destination window.

- **Fit Page**
  Displays the current page in the window.

- **Fit Visible**
  Displays the width of the visible contents of the current page in the destination window. This usually means the margins are not displayed.

Absolute / Relative Addressing:

Absolute or relative addressing can be used in the action bookmark properties: Open File and Go To Remote View. It allows users to configure the method of referencing to a file.

- **Absolute Addresses**
  These are best used when it's likely that the source document may need to be moved or copied to a different location in the file system, without any target files moving in relation.

  **Note:** By default, browsing to the target file using the Open File dialog produces an absolute address i.e. target.pdf
• **Relative Addresses**

These are most appropriate for PDFs published to CDs/DVDs or when the entire file system is copied and must remain relative to the source. Relative addresses describe the path to a file, relative to another file, in most cases the Bookmarker file that was loaded last.

To use *relative addressing*, please follow the following syntax

For example:

If the file is in the same folder, then use
\target.pdf

If the file is in one folder above, then use
..\target.pdf

If the file is in two folders above, then use
..\..\target.pdf

If the file is in one folder below, then use
./directorybelow/target.pdf

### 4.3.1.3. Removing Bookmarks

To remove a single bookmark from the preview pane:

1. Select the bookmark you wish to remove.
2. Click the 'Remove’ button.
3. Click ‘Yes’.

**Note:** If the bookmark has any child bookmarks (i.e. bookmarks with lower level bookmarks attached to it) they will also be deleted.

To remove multiple bookmarks from the preview pane:

1. Hold down Ctrl and click on the bookmarks you wish to remove. Alternatively, you can press Ctrl + A to select all bookmarks.
2. Click the ‘Remove’ button.
3. Click ‘Yes’.
4.3.1.4. Import Bookmarks from a PDF

This function enables you to import existing bookmarks from the active PDF document into the Add Bookmark's preview pane. It will retain the same bookmark level structure as displayed in the PDF document.

To copy or extract bookmarks from the open PDF document into the preview pane:
1. Click on the 'Import...' button.
2. Select 'From current PDF'.
3. Click 'OK'.

4.3.1.5. Moving Bookmarks

From the Add Bookmark's preview pane, you can select and drag bookmarks around using your mouse. To move a bookmark:
1. Select the bookmark you wish to move. If you wish to move a bookmark that contains child bookmarks, then the child bookmarks will also be moved.
2. Holding the mouse button down, drag the bookmark to the desired location.

When dragging a bookmark the following symbols may appear:
- ≈ Indicates bookmark will be on the same bookmark level.
- ↔ Indicates bookmark will become a child node.
- ⊙ Indicates that the bookmark cannot be moved to this location.

For example:
If you wish to move a bookmark (Bookmark#1) below another bookmark Bookmark#2:
1. Select Bookmark#1
2. Hold down the mouse and drag Bookmark#1 until Bookmark#2 is highlighted and ≈ or ⊙ appears.
4.3.2. **Add Bookmarks to PDF**

To add bookmarks from the preview pane to the open PDF document, click ‘OK’.

**Note:** There are options available when adding bookmarks to the PDF document, see Insertion Options and Expand / Collapse options.

4.3.2.1. **Insertion Options**

The insertion options drop down box has three options that allow you to choose how you want to display the new bookmarks. The three options are:

- **Overwrite**
  Bookmarks will overwrite the existing bookmarks. Choosing this option then clicking on Update will replace the whole bookmark structure with the newly created one.

- **After**
  Newly created bookmarks will be appended after the existing bookmark structure.

- **Before**
  Newly created bookmarks will be appended before the existing bookmark structure.

4.3.2.2. **Collapse Bookmarks Options**

Use this option to set the display default of your bookmarks.

- **Collapse Bookmarks**
  If you want to only display the first level bookmarks, the collapse bookmarks option has to be checked. This means that the other levels of the bookmarks structure will not be visible.

- **Expand Bookmarks**
  If you want to display all the levels of the bookmarks structure, then uncheck the collapse bookmarks box. Result of this would be having the bookmarks displayed in an expanded form, that is all the levels of the bookmark structure will be visible.

4.3.3. **Importing/Exporting Bookmark Settings**

With the Import feature you can save your current bookmark settings with the Add Bookmarks preview pane. You can then load it at a later date using the Import feature.
4.3.3.1. Importing Tools

To load or import your bookmark settings from a file:
1. Click the 'Import…' button.
2. Select ‘From settings file’
3. Click on the ‘…’ button and browse to the location of the file you wish to import.
4. Select the file to import and click ‘OK’.

In the Add Bookmarks function you can import bookmarks from a PDF file, Debenu PDF Bookmarks settings, Comma-delimited files or Tab-delimited files:

- **PDF files (*.pdf)**
The bookmarks will be copied from the selected PDF document.

- **Add Bookmarks settings files (*.ina)**
‘Add Bookmarks settings’ files can be created using the Export function of Add Bookmarks.

- **Comma-delimited files (*.csv)**
Comma-delimited file types can be created using a text editor such as Notepad or a spreadsheet application such as Microsoft Excel. These files must have the following structure for each bookmark entry:

  Bookmark level, Bookmark name, Zoom, Destination, Zoom

where:
- **Bookmark level** = a numeric value. “0” being the highest bookmark level.
  - 0 – Level 1 bookmark
  - 1 – Level 2 bookmark
  - 2 – Level 3 bookmark
- **Bookmark name** = the bookmark name displayed in the Bookmarks tab of Acrobat's Navigation pane
- **Zoom** = a numeric value.
  - 0 – Custom Zoom Magnification (Fixed)
  - 1 – Fit Width
  - 2 – Fit Height
  - 3 – Fit Page
  - 4 – Fit Visible
- **Destination** = the page number where the bookmark will link in the document.
- **Zoom Magnification** = the percentage level for zoom magnification. This is required if “0” is set for Zoom.
• **Tab delimited files (*.txt)**
  Tab-delimited file types can be created using a text editor such as Notepad or a spreadsheet application such as Microsoft Excel. Tab-delimited files must have the following structure for each bookmark entry:

  
  ```
  ```

  where:
  - **Bookmark level** = a numeric value. "0" being the highest bookmark level.
    - 0 – Level 1 bookmark
    - 1 – Level 2 bookmark
    - 2 – Level 3 bookmark
  - **Bookmark name** = the bookmark name displayed in the Bookmarks tab of Acrobat’s Navigation pane
  - **Zoom** = a numeric value.
    - 0 – Custom Zoom Magnification (Fixed)
    - 1 – Fit Width
    - 2 – Fit Height
    - 3 – Fit Page
    - 4 – Fit Visible
  - **Destination** = the page number where the bookmark will link in the document.
  - **Zoom Magnification** = the percentage level for zoom magnification. This is required if "0" is set for Zoom.

  Example:

  ```
  0 LinkPage1 0 1 100
  0 LinkPage2 0 2 100
  0 LinkPage13 0 13 100
  0 LinkPage20 0 20 100
  ```

### 4.3.3.2. Exporting Tools

To save or export your bookmark configuration to a file:

1. Click the 'Export..' button.
2. Browse to the location that you wish to store the file in.
3. Enter the filename.
4. Click 'OK'.
4.4. Finding and Replacing Bookmarks

The Find Bookmark function allows you to delete or replace only the bookmarks that match the search criteria you specify; once you have entered the content to search for, Find Bookmarks scans the text of all the bookmarks of the PDF files you have selected and updates them based on the text and properties changes you have specified.

![Find Bookmarks dialog box]

Find and Replace Bookmarks
4.4.1. Find Options

When searching the Bookmark text the following two options are available, in order to make it as relevant as possible.

- **Is complete bookmark name**
  This will only perform Find/Replace actions on bookmarks that completely match the specified search text

- **Case sensitive**
  This will only perform the action on bookmarks whose text is exactly the same case as that specified.

Finding Bookmarks

E.g. A case-sensitive search of “And” will not perform any actions on a bookmark containing “and”.

4.4.2. Replace Options

- **Delete**
  Deletes any bookmarks that match the Find criteria

- **Replace with – Name**
  Replaces the text entered in the Find textbox with the text in the Replace textbox. If you enable the "Replace whole text" checkbox, all of the bookmark text is replaced.

- **Replace with – Color**
  Replaces the bookmark font colors. You can choose from the standard Acrobat colors, and also create your own custom colors using the custom color palette. The custom color palette can be found by selecting ‘custom…’ from the color list.

- **Replace with – Style**
  Replaces the current font style with:
  - Plain
  - Bold
  - Italic
  - Bold and Italic
• **Replace with – Action**
  Replaces the current bookmark action with the specified one. For information on what each action does, see the Action section in [Bookmark Properties](#):
  - None
  - Go To View
  - Go To Remote View
  - Open file
  - Read Article
  - Show/Hide Field
  - Submit Form
  - Reset Form
  - Import Form Data
  - JavaScript
  - Execute Menu Item
  - Movie (Play a movie)
  - Sound (Play a sound)
  - World Wide Web Link

### 4.4.3. Using Text Masking

Text masking can be used to perform complex find and replace matches. Text masking would be used in the ‘Find’ text box. See section [Using Text Masking](#) for full details on the correct text masking syntax.
4.5. Deleting Bookmarks

This is the easiest function to use – simply click on the Delete Bookmarks button or the menu item: Plug-ins > Debenu PDF Aerialist™ > Bookmarks > Delete Bookmarks.

Be careful when using this function, as Acrobat cannot undo the deletion of bookmarks. If you have accidentally deleted them the only way to retrieve them is to exit the document without saving, and then open it again.
4.6. Building Bookmarks

The Build Bookmarks function can automatically generate bookmarks based on the font styles and layout used in your PDFs. After specifying the combination of attributes that must exist for a bookmark to be generated, the Bookmarks function can quickly scan one or more PDF files to build the bookmarks for each document. Use the Import/Export functionality so you can reuse Build Bookmarker settings to process large collections of PDF files.

![Building Bookmarks Dialog]

Building Bookmarks Dialog
4.6.1. Creating Bookmarks

Creating bookmarks using the Build Bookmarks function is simple. Using the selection criteria you can be very selective in what text is created into bookmarks.

To build bookmarks follow this basic outline:

1. In the Build Bookmarks dialog, click “Level 1”. This will open up the Select Bookmark Attributes dialog.

   Dialog 1 - Bookmark Attributes

   ![Select bookmark attributes dialog]

2. Enable the checkboxes of the properties that you wish to create the bookmarks from. These properties are detailed in the Bookmark Properties section.

3. Move the mouse over the PDF document. The pointer will change to a crosshair. Select the text you wish to grab the properties from, and drag a rectangle around it with the mouse.
   Alternatively you can use the pull-down menus provided to select the properties manually, or you can use a combination of both mouse and manual selections.

4. Once you have made your selections, click “OK”

5. You can now create a Level 2 bookmark. To create a Level 2 bookmark just follow Steps 1–4.
   Once you have created a Level 2 bookmark you can go on to create a Level 3 bookmark, and so on.
6. If you wish to remove a bookmark level, simply click its corresponding “Clear” button in the main dialog. If you clear a bookmark level when there are bookmark levels created below it, they will also become unavailable.

7. Set the Magnification Options you wish the bookmarks to open the pages with.

8. Set the Insert Options and Expand / Collapse Options.

9. Set the Bookmark exact text only option. Select this option to create bookmarks from text that matches the exact font style. If this option is not selected, the whole line of text where this font style is found will be bookmarked.

10. When you are happy with your configuration, click “Build” to commence creating bookmarks.

### 4.6.2. Importing/Exporting Bookmark Build Options

With the Import feature you can save your current bookmark settings with the Add Bookmarks preview pane. You can then load it at a later date using the Import feature.

#### 4.6.2.1. Importing Bookmarks

To load or import your bookmark settings from a file:

1. Click the ‘Import…’ button.
2. Browse to the location of the file you wish to import.
3. Select the file to import and click ‘OK’.

**Note:** Importing will replace any current bookmark settings with those from the imported file.

#### 4.6.2.2. Exporting Bookmarks

To save or export your bookmark configuration from the Build Bookmarks dialog to a file:

1. Click the ‘Export..’ button.
2. Browse to the location that you wish to store the file in.
3. Enter the filename.
4. Click ‘OK’.

### 4.6.3. Bookmark Selection Properties

There are five text properties that can be used when choosing the properties that the bookmarks will be created from. Combining the various properties will create bookmarks that only match the criteria of the combined properties. If the text in the document does not meet the requirements of the properties then no bookmarks will be created.

- **Font Name**
  Creates bookmarks from the selected font. Clicking “Update Font Name” will update the font menu listing to include all the fonts contained in the document. Embedded fonts will not be included.

- **Font Size**
Creates bookmarks from text that conforms to the specified font size.

- **Font Color**
  Creates bookmarks from text that matches the selected text’s color.

- **Left Indentation**
  This will create bookmarks from text with its line indent starting the specified distance from the left-hand side of the page. An example of line indentation are bullet headings – selecting these bullet headings with the ‘Left Indentation’ and ‘Font Name’ properties enabled would produce bookmarks from the bullet headings: Font Name, Font Size, Font Color, Left Indentation and Text Mask (if the ‘Font Name’ property wasn’t enabled, all text with the same indentation as the bullets would be turned into a bookmark).

  **Note:** the Bookmarks function will select text whose line indentation starts at the start of the rectangle that you draw. It is important to know this, because if you select a section of text whose line indent is not included inside your selection rectangle, then the Bookmarks function will not create a bookmark from that text. For more information on using this property, visit the **Troubleshooting** section.

- **Text Mask**
  Creates bookmarks from text that matches the characters entered into the Text Mask textbox. Text masking is great when there are no defining bookmark properties, or if you need to selectively filter out certain text that may otherwise become a bookmark.

  As Text Masking contains a number of special characters that can be complicated, a section of this User Guide has been dedicated to its use. See section **Using Text Masking** section for more information on special Text Mask characters.

- **Keyword list**
  This feature allows users to include and exclude particular bookmarks based on its name. The keyword list file is simply a text file with a list of words. If the keyword list is excluded, it will only build bookmarks that do not have any of the words in the bookmark name. If the keyword list is included, then it will only build bookmarks that contain the word in its name.

  For example:

  From the bookmark properties selected, the Build Bookmarks function should build bookmarks named:
  - Table Of Contents
  - Introduction to Debenu PDF
  - Part I - Debenu
  - Part II - PDF
  - Part III – Other
If the user chooses to include a keyword list (e.g. sample.txt) that contains:
Debenu
PDF
The Build Bookmarks function will only build bookmarks:
• Introduction to Debenu PDF
• Part I - Debenu
• Part II - PDF

If the user chooses to exclude a keyword list (e.g. sample.txt) that contains:
Debenu
PDF
The Build Bookmarks function will only build bookmarks:
• Table Of Contents
• Part III – Other

• Ignore repeated headings
Creates a bookmark for only the first occurrence of a repeated bookmark name.

• Multi-lined headings
Creates bookmarks from text spanning over more than one line.

• Leading numbers
This feature allows you to add or remove leading numbers to bookmarks.

For example:

#1.
Suppose Debenu PDF Bookmarker is to build bookmarks named:
• Introduction
• Contents
  • Install
    • Windows
    • Macintosh
• Quick Start Up
  • Where To Start
• Index

If you choose to add leading numbers, Debenu PDF Bookmark will build bookmarks:
• 1 Introduction
• 2 Contents
  • 2.1 Install
    • 2.1.1 Windows
    • 2.1.2 Macintosh
  • 2.2 Quick Start Up
    • 2.2.1 Where To Start
• 3 Index
#2.
Suppose Debenu PDF Bookmarker is to build bookmarks named:

- 1.0 Introduction
- 2.0 Contents
- 3.0 Install

If you choose to remove leading numbers, Debenu PDF Bookmark will build bookmarks:

- Introduction
- Contents
- Install

### 4.6.3.1. Using Text Masking

The text masking property has a number of special characters allowing you to selectively create bookmarks. They are described in detail below with simple examples provided.

**Note:** The user should be aware that the Bookmarks feature processes text by lines of text, and produces a bookmark out of the whole line of text. For example, if you specified “sales” in the text mask field, and your PDF document had a line in it with the text “and so to conclude, our company had no major sales this month”, this whole line of text will be turned into a bookmark.

#### Macintosh

Macintosh users can simply enter partial words to bookmark a line of text. Any line containing the characters will create a bookmark. It is not case sensitive.

Example: Entering “en” will create bookmarks from any lines of text containing “en” such as “Enjoy”, “entertain”, “content”, “burden” etc.

#### Windows

- **Case sensitive:** Text Masking is case sensitive, so entering “ABC” will create different bookmarks from “abc”.

- **.:** The “.” matches one instance of any character.

  Example: Entering the expression “P.F” into the Text Mask field, it would create a bookmark from any lines of text containing “PDF, PeF, PdF,” etc.

- **^:** The “^” only creates a bookmark if the specified text appears at the very start of the line.
Example: Entering the text "^abc" will only create a bookmark if the line started with "abc". If a line of text started with "1.0 abc" no bookmark of it would be created.

- $: The "$" only creates a bookmark if the specified text appears at the very end of the line.

Example: Entering the text "abc$" will create a bookmark only from text with lines ending with "abc", so "...xyzabc" would cause a bookmark of that line to be created, but "abcxyz" would not have a bookmark created.

- If you only want to create bookmarks from lines that only contain the exact text you specify, use both the "^" and "$" characters.

- [ ] : Any lines containing characters inside the "["] will be created into a bookmark. Characters can be specified literally, or as a range of characters.

Example: "[abc]" will create bookmarks from any lines containing either a, b, or c. This is opposed to only creating a bookmark from text containing abc if "abc" is entered.

"[a-dA-D]" will create bookmarks from lines containing any of the characters between a-d (that is, a, b, c and d), in both lower and upper-case.

-[^] : Any text containing characters inside the "["] and after the "^" will not be turned into bookmarks. This feature is very handy when applied in conjunction with other bookmark selection properties to stop unwanted bookmarks from being created. Please be aware that conversely this means that any other text not in the "["] will be considered as potential bookmark material. Therefore it is suggested that another bookmark selection property is used in conjunction with this one.

Example: Entering "[^0-9]" will still create bookmarks containing numbers if the text line contains any other character – 1.0 will be turned into a bookmark because it contains a ".".

If you really want to exclude numbers like 1.0 you would need to modify it to "[^0-9].\". The "\" is explained below, and is needed because "." is a considered special character in text masking.

- \ : The "\" character is used when you wish to actually match a special character, such as "." Or ".\". These special characters are used in the Text Mask field to perform special text matching.

Example: Entering "\$" will search and create a bookmark from text on the document containing a ",", ignoring the normal "$" text mask command.

- * : Use the "*" character to create bookmarks from more than one set of characters at the same time.
Example: Entering “a*b” will create bookmarks from any line of text containing either a and/or b.

- +: Use the “+” character to create bookmarks from a set of characters arrayed in a certain order. Bookmarks can be created from the first character(s) before the “+”, however, characters after the “+” can only be bookmarked if the characters before the “+” are also present.

Example: Entering “a+b” will create bookmarks from any line of text containing ab, aab, aaab, etc. Any text like ba, or cb, will be ignored.

- ?: Like the “+” character, the “?” character creates bookmarks from a set of characters arrayed in a certain order, but in this case, bookmarks can be created from characters before the “?” only if the proceeding characters are also present. The characters after the “?” can be used to create bookmarks, irrespective of whether characters before the “?” are present.

Example: Entering “a?b” will create bookmarks from any line of text containing ab, abb, or just b.

- ( ): Allows characters to be grouped together and be combined with other special characters.

Example: “(a*b)$” will create bookmarks from lines of text containing either a and/or b, but only if these lines end with a or b.

- |: Creates bookmarks from either one set of characters or another.

Example: Entering “a | b” into the Text Mask field will create bookmarks from lines of text containing either a or b.
4.7. **Page Bookmarks**

Generating bookmarks every Nth page enables users to create a bookmark from every Nth page. Where N is number set by user. There are two practical uses for this. For example, if a user opens a 20-page document and set the N to 4, then bookmarks will be created for pages 4, 8, 12, 16 and 20.
4.8. Sorting Bookmarks

The Sort Bookmarks feature allows the user to sort their bookmarks in alphabetical order. The bookmarks can be sorted in ascending or descending order. You can sort an entire level of bookmarks or select a particular node of bookmarks.

- **Level/Nodes**

Entering a level:

To enter a level you must put ‘L’ in front of the bookmark level value. Level one (L1) is the highest bookmark level.

For example:
- If you want to sort all level one bookmarks, you would enter L1.
- If you want to sort all level two bookmarks, you would enter L2.

Entering a node:

Enter a node value and separate node values with a comma.

For example:
- If you only wanted to sort bookmarks that are in the third (3) bookmark’s second (2) child bookmark, you should enter 3,2.
• **Ascending or Descending**

This option allows you to select whether you want to sort your bookmarks in ascending or descending order.

• **Apply to child nodes**

If selected, all child bookmarks to the bookmarks specified in ‘Level/Node’ will also be sorted.

For example:

Take the initial bookmark structure as follows.

- B
  - A
    - 3
    - 2
      - two
        - four
        - three
        - one
    - 1
- 3

Example #1:
Settings: Level/Node=L2; Apply to child nodes=not selected; Order=ascending.
Result: Only the level two bookmarks will be sorted.

- B
  - A
    - 1
    - 2
      - two
      - four
      - three
      - one
    - 3

Example #2:
Settings: Level/Node=2,2; Apply to child nodes=selected; Order=ascending.
Result: Bookmarks under the second bookmark’s second node will be sorted.

- B
  - A
    - 3
    - 2
      - four
      - one
      - three
      - two
    - 1
4.9. **Edit All Properties**

The Edit All Properties feature lets you edit all bookmark properties for the current PDF. Change the appearance, style and magnification of bookmarks as well as actions. Modify all bookmark levels or only a specific bookmark level.
4.10. Insert Destination Offset

Insert Destination Offset is for documents with broken bookmarks as a result of missing or new pages. Debenu PDF Aerialist 12 fixes broken bookmarks by inserting a destination offset for the affected number of pages from a specified bookmark downwards.

The page offset can be a positive or negative number. Use negative number (e.g. -1) to decrease the page count and a positive number (e.g. 1) to increase the page count.

If there are 10 pages, each page is bookmarked where the bookmark points to the page number and for some reason the 7th page is removed this will play havoc with where the bookmarks point to. Bookmark 7 will point to page 8, Bookmark 8 will point to 9 etc.

Insert Destination Offset remove bookmark 7 each subsequent bookmark page destination is decreased by 1 so bookmark 8 now becomes bookmark 7 and bookmark 9 becomes bookmark 8 and so on.

Here is a visual example:

# Normal (no missing pages) #

Page 1 pointed to by bookmark 1
Page 2 pointed to by bookmark 2
Page 3 pointed to by bookmark 3
Page 4 pointed to by bookmark 4
Page 5 pointed to by bookmark 5
# Irregular (missing pages) #

Page 1 pointed to by bookmark 1  
Page 2 pointed to by bookmark 2  
Page 3 pointed to by bookmark 3  
Page 4 pointed to by bookmark 4  
Page 5 pointed to by bookmark 5  
Page 6 pointed to by bookmark 6  

>>> Page 7 <<< (missing) pointed to by bookmark 7 (missing page)

Page 7 pointed to by bookmark 8  
Page 8 pointed to by bookmark 9  
Page 9 pointed to by bookmark 10

# Fixed with Debenu PDF Aerialist 12 Insert Destination Offset #

Page 1 pointed to by bookmark 1  
Page 2 pointed to by bookmark 2  
Page 3 pointed to by bookmark 3  
Page 4 pointed to by bookmark 4  
Page 5 pointed to by bookmark 5  
Page 6 pointed to by bookmark 6  

>>> Page 7 <<< pointed to by bookmark 7 (missing page) *Fix outlined below.

Page 7 pointed to by bookmark 7  
Page 8 pointed to by bookmark 8  
Page 9 pointed to by bookmark 9

* Bookmark 7 is removed and each subsequent bookmark page destination is decreased by 1 so bookmark 8 now becomes bookmark 7 and bookmark 9 becomes bookmark 8 and so on.
4.11. Bind Documents

The Bind Documents feature lets you interlink PDFs by automatically generating a set of bookmarks based on the folder and file names of the selected root folder. The set of bookmarks is then applied to each file separately in the root folder or alternatively all the PDFs are merged into one PDF and the set of bookmarks is applied to it.
4.12. Collapse and Expand Bookmarks

The Collapse/Expand Bookmarks feature lets you collapse and expand all bookmarks in the current PDF. Change all bookmark levels or only specific levels. To change multiple bookmark levels use the ‘Collapse defined bookmark levels’ option with the letter “L” for level followed by the bookmark level number (e.g. L1,L3).

![Collapse/Expand Bookmarks](image)

**Collapse/Expand Bookmarks**

**Action Settings**

- Collapse
- Expand

**Collapse/Expand Settings**

- Collapse all bookmarks
- Collapse bookmark level: 1

- Collapse defined bookmark levels:

Start | Cancel
5.1. Overview

Using Debenu PDF Aerialist™ stamp text, watermarks and backgrounds to pages on a PDF document. With Debenu PDF Aerialist’s™ Stamp features, users can customize the content, appearance and action of each stamp as well as combining multiple stamps into one stamp profile. This includes aligning and setting the size of each stamp, or even making your stamps behave like hyperlinks.

Using the Stamp feature, you can:

- Stamp text and dynamic text
- Apply Page and Bates Numbering
- Apply image watermarks (BMP, RLE, DIB, GIF, JPG, PCX, PNG, EPS and TIFF)
- Stamp one PDF onto another
- Specify the position, scale and angle of rotation for text and image stamps
- Set actions for individual stamps.
- Combine single stamps into a profile for faster application.
- Copy and paste stamps between profiles
- Save profiles for later use
- Set up batch processes to apply stamps across many files.

Debenu PDF Aerialist’s™ stamp tool button
5.2. Main Features

The main features of Debenu PDF Aerialist’s™ Stamp set are:
- Stamp text on a PDF file
- Stamp an Image on a PDF file
- Stamp a page from a PDF document on another PDF document.

5.2.1. Text Stamps

Use this feature to create single or multi-line text stamps. Text stamps are often used for headers, footers and hyperlinks. A variety of Dynamic Text options are available to allow you to easily insert date, time, page numbers and document information such as Author, Title and Subject at runtime.
5.2.2. Image Stamps

Image stamps enable you to stamp single or multiple images on PDF document. Debenu PDF Aerialist™ supports a number of different image types. These include BMP, RLE, DIB, GIF, JPG, PCX, PNG, EPS and TIFF formats.

5.2.3. PDF Stamps

Stamp a page from a PDF onto another document. You can modify the placement, layout and action of the PDF stamp in the same way as text and the image stamps.
5.3. Using Stamps

To use the Stamp feature, first locate the Stamp tool button or menu item under Acrobat’s Plug-in menu. Use either the toolbar or the menu items from Acrobat’s menu to create, edit, manage or apply a stamp to a document. Once a stamp profile is created, you can use it to easily stamp the active document by selecting it from either the tool button drop down or ‘Plug-ins > Debenu PDF Aerialist™ > Stamp’ menu.
Stamp a document

To apply a stamp, open a PDF document and select or create your desired stamp profile.

To select a stamp either:
- Open the Manage Stamps dialog and select the profile from the list. Click ‘Stamp’ to process.
- Select a stamp profile from the Stamp menu.
- Click the drop down tool button.

Once selected, the active document will be stamped with the chosen profile.

Note: All the stamps within a profile are applied to the document. If a stamp is selected rather than the profile, the ‘Stamp’ button is disabled.

5.3.2. Undo Stamp

To remove or undo the last stamp applied simply select ‘Undo’ from the Stamp menu or tool button. You cannot undo a stamp if the document was saved after being stamped.
5.4. Managing Stamps and Profiles

To activate the Stamp Management dialog, click the Stamp tool button or select ‘Manage Stamps’ from the ‘Plug-ins > Debenu PDF Aerialist™ > Stamp’ menu item.

The Stamp feature uses stamp profiles, allowing users to apply any combination of stamps in a single action. Stamp profiles also allow users to copy and share stamps between profiles. For example, an individual copyright footer, company logo and page numbers can be stored within a single profile. When stamping with this profile, all stamps are applied to the open document(s) when processed.

The stamp profiles are saved for reuse. Profiles can also be shared by different users using the import and export features. Saved profiles are stored (with a .nxp extension) in the Profiles subfolder of the installation directory, i.e. C:\Program Files\Adobe\Acrobat 6.0\Acrobat\plug_ins\Debenu PDF Stamper\Profiles.

Main Dialog – Managing all stamp profiles
5.4.1. Creating a new Profile

To create a new Profile:
1. Open the Manage Stamp dialog.
2. Click ‘New Profile’.
3. Add stamps as required to this profile by clicking the ‘Add Stamp’ button (refer to Designing stamps).
4. The stamp is automatically saved.

5.4.2. Creating a new Stamp

To create a new Stamp:
1. Select the profile you want the stamp added to.
2. Click the ‘Add Stamps’ button and select a stamp type from the list (refer to Designing stamps).

5.4.3. Previewing a Profile/Stamps

To preview a Profile or a Stamp:
1. Ensure that a PDF is open in Acrobat.
2. Select a profile to view all stamps. It is also possible to view individual or a variety of stamps by clicking on the stamp rather than profile (hold the Ctrl key to select multiple).
3. If the ‘Preview On’ checkbox is not already checked, check it to preview the desired stamps and/or profile.

5.4.4. Renaming Profiles/Stamps

To rename a profile/stamp from the preview pane:
1. Right click the desired profile or stamp.
2. Select ‘Rename Stamp’ or ‘Rename Profile’ from the popup menu.
3. Enter in the new name.

---

3 Previewing large documents and profiles that contain a large number of stamps can result in performance degradation. Refer to the FAQ section for tips on reducing this.
5.4.5. **Deleting Profiles /Stamps**

To delete a profile/stamp from the preview pane:
1. Right click the desired stamp or profile
2. Select ‘Delete Profile’ or ‘Delete Stamp’ from the popup menu.
3. Press ‘Yes’ or ‘No’ to confirm the delete action.

**Note:** If the Profile contains several stamps, deleting the profile will delete all the stamps within the profile. Delete actions cannot be undone.

5.4.6. **Rearranging Stamps**

The Stamp feature provides a number of ways to rearrange, edit and share stamps between profiles.

To cut or copy stamps from one profile to another:
1. Select the desired stamps using the mouse cursor
2. Right click an item in the selection
3. Select ‘Cut’ or ‘Copy’
4. Right click the destination profile and select ‘Paste’

**Note:** Stamps can also be dragged from one profile to another by holding the left mouse button and dragging the stamps to another document.

To create a copy of a profile:
1. Right click the desired profile
2. Select ‘Copy’
3. Right click somewhere within the frame and select ‘Paste’

5.4.7. **Importing / Exporting Profiles**

To export profiles to file to archive or share:
1. Select the desired profile from the Stamp Management dialog
2. Either right click and select ‘Export Profile’ or click the ‘Export’ button
3. Navigate to the desired destination and enter the filename

To import profiles:
1. Open the Stamp Management dialog
2. Click the import button
3. Navigate and select the desired profile to import

**Note:** When importing profiles only the settings are imported. Any links to the source image/PDF files may be broken and it is important these are checked, validated and repaired as required.
5.4.8. Editing Stamps

To edit an existing stamp, select the desired stamp and click the edit button. The Edit Stamp function allows users to modify the properties of individual stamps. Editing is disabled unless a profile is selected. More detail in section Designing Stamps.

5.4.9. Right Click Menus

As mentioned above, a number of editing features are available by right clicking a stamp or profile. For Mac users, use standard shortcut keys to copy (Apple-C), cut (Apple-X) and paste (Apple-V).
5.5. Designing Stamps

The stamp design dialogs are used to tailor the content, alignment, spacing and placement of a stamp. These properties are described below.

5.5.1. General Stamp Settings

Settings common to text, image and PDF stamps are outlined in this section.

5.5.1.1. Layout

**Units**
Select ‘cm’, ‘mm’ or ‘inch’ from the drop down.

**Horizontal Position**
Select the horizontal point of reference for the stamp. Adjust by entering a value in the text box.
- *From right* (right justified) - incrementing moves stamp to the left.
- *From left* (left justified) – incrementing moves stamp to the right.
- *From center* (centered) – positive increment moves stamp right, negative move left.

**Vertical Position**
Select the vertical point of reference for the stamp and using by entering a value in the text box.
- *From top* – Stamp is applied to top of document. Incrementing moves stamp down.
- *From left* - Stamp is applied to bottom of document. Incrementing moves stamp up.
- *From center* (centered) – positive increment moves stamp up, negative move down

**Rotation**
Rotate your stamp by a value between -360° and 360°.

**Opacity**
Apply opacity to your stamps to create a watermark effect. Enter a value in the range of:
- 100% (no transparency)
- 0% (completely transparent)

**Overlay & Underlay Options**
Select one of two options by checking the radio button next to it.
- Overlay places the stamp on top of all objects on the PDF document.
- Underlay places the stamp below all objects on the PDF document.
By adjusting the stamp order in the Profile dialog, it’s possible to create a number of different variations.

### 5.5.1.2. Pages Options

Set which pages to stamp on by selecting a predefined range:

- All pages
- Odd pages
- Even pages
- First page
- Last page

Alternatively, define your own page range, i.e. 2, 5, 9-16 or by page groups, stamp from page 2 every 4 pages, i.e. 2, 6, 10, 14.

### 5.5.1.3. Border and Outline Font

Apply a rectangular border around the edge of your text, image or PDF stamp. Set the color, line style (dashed) and weight. Fill the border with a color from the drop down or define your own by selecting ‘Other Color…’

When using this option in conjunction with text stamps, there is a choice of including the border as an outline to the text or to apply a border around the text.

<table>
<thead>
<tr>
<th>Standard border</th>
<th>Text outline</th>
</tr>
</thead>
</table>

### 5.5.1.4. Applying Actions to Stamps

The Stamp feature also allows actions to be associated with stamps. To do this, select one of the following actions:

- **None**: No action is related to the active stamp.
- **Go To View**: This action will jump to the specified page in the document. This page must be specified using the ‘To Page’ spin box.
- **Go To Remote View**: This opens a specified PDF document at the designated page. Various page magnification options are also available; see Magnification Options. This can be configure using relative or absolute addressing, see Absolute / Relative Addressing.
• **Open File**: Opens the specified file. This file can be of any type, but only files with a *.pdf extension will be opened in Acrobat; all other file types will be opened in their default viewers. The path to the file can be configured using an absolute or relative address, see **Using Absolute / Relative Addressing**.

• **Open a web Link**: Clicking on the bookmark opens a web browser to the URL specified within the WWW Link textbox.

• **Read Article**: Selecting this action will link or display the bookmark to an article thread in the active document.

• **Show / Hide Field**: Provides the option of either showing or hiding fields in a PDF document.

• **Submit Form**: This will send the form data to a specified URL.

• **Reset Form**: Resets all form fields to their original default value.

• **Import Form Data**: Imports in form data from another file and displays it in the active form.

• **JavaScript**: This option will run a specified JavaScript

• **Execute Menu Item**: Executes a specified menu command as the action when the bookmark is clicked.

• **Movie**: Plays a specified QuickTime or AVI movie.

• **Sound**: Plays a specified sound file.

### 5.5.1.5. Using Absolute / Relative Addressing

When creating stamps that execute an open file or GoTo remote page action it is possible to specify whether to use absolute or relative file addresses.

**Absolute Addresses**

Absolute Addresses are best used when it's likely that the stamped document may need to be moved or copied to a different location in the file system, without any target files moving in relation.

By default, browsing to the target file using the Open File dialog produces an absolute address i.e. C:\target.pdf

**Relative Addresses**

Relative Addresses are most appropriate for PDFs published to CDs/DVDs or when the entire file system is copied and must remain relative to the source. Relative addresses describe the path to a file, relative to the source PDF.
To use relative addressing, please follow the following syntax
For example:

You have the stamped PDF file 'stamped.pdf' and is stored in a directory
C:\directory 1\directory 2\ (i.e. C:\directory 1\directory 2\stamped.pdf)

- If the file to open with the action stamp is in the same directory as the
  stamped document ('stamped.pdf')
  i.e. C:\directory 1\directory 2\target.pdf
  then use '\target.pdf'

- If the file is in one directory above the stamped document
  i.e. C:\directory 1\target.pdf
  then use '../target.pdf'

- If the file is in two directories above the stamped document
  i.e. C:\target.pdf
  then use '../..\target.pdf'

- If the file is in one directory below the stamped document
  i.e. C:\directory 1\directory 2\directory 3\target.pdf
  then use '.\directory 3\target.pdf'
5.5.2. **Text Stamp Properties**

![Text Stamp Properties](image)

**Designing Text Stamps**

5.5.2.1. **Line spacing**

When creating multi-line text stamps, alter this setting to adjust the space between lines. Lines are created using the enter key.

**Note:** line spacing adjustments will appear only in the preview pane or output file – not in this text box.
5.5.2.2. Dynamic Text

Dynamic Text is used to insert variable data (such as document information fields) and information that is calculated at runtime such as page numbers and time.

To use dynamic text, select an item from the drop down list and press ‘Insert’. A specific macro to identify the dynamic text will be inserted into the text box.

<table>
<thead>
<tr>
<th>Dynamic Text</th>
<th>Macro</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Number</td>
<td>$PageNo[1]</td>
<td>Page number in document starting at 1</td>
</tr>
<tr>
<td>Total Pages</td>
<td>$TotalPages</td>
<td>Total pages in document</td>
</tr>
<tr>
<td>Batch Page Number</td>
<td>$BatchPageNo[1]</td>
<td>Current page in the batch process is 1</td>
</tr>
<tr>
<td>Batch Total Pages</td>
<td>$BatchTotalPages</td>
<td>Total pages in the batch process</td>
</tr>
<tr>
<td>Bates Number</td>
<td>$BatesNo[1]</td>
<td>A number in Bates format starting at 1</td>
</tr>
<tr>
<td>Bates Total Pages</td>
<td>$BatesTotalPages</td>
<td>Total number of pages in Bates format</td>
</tr>
<tr>
<td>Title</td>
<td>$PDInfoTitle</td>
<td>Document title field</td>
</tr>
<tr>
<td>Author</td>
<td>$PDInfoAuthor</td>
<td>Document author field</td>
</tr>
<tr>
<td>Subject</td>
<td>$PDInfoSubject</td>
<td>Document subject field</td>
</tr>
<tr>
<td>Keywords</td>
<td>$PDInfoKeywords</td>
<td>Document keyword</td>
</tr>
<tr>
<td>File Name</td>
<td>$FileName</td>
<td>Name of file with the file extension</td>
</tr>
<tr>
<td>File Path</td>
<td>$FilePath</td>
<td>Local path of the file</td>
</tr>
<tr>
<td>Date</td>
<td>$Date</td>
<td>Date format is dependent on regional settings</td>
</tr>
<tr>
<td>Time</td>
<td>$Time</td>
<td>Time format is dependent on regional settings</td>
</tr>
<tr>
<td>Day</td>
<td>$Day</td>
<td>Day of the month – numerical</td>
</tr>
<tr>
<td>Month</td>
<td>$Month</td>
<td>Month – numerical</td>
</tr>
<tr>
<td>Year</td>
<td>$Year</td>
<td>Year – numerical</td>
</tr>
<tr>
<td>Hour</td>
<td>$Hour</td>
<td>Hour – 24 hour</td>
</tr>
<tr>
<td>Minute</td>
<td>$Min</td>
<td>Minutes</td>
</tr>
<tr>
<td>Second</td>
<td>$Sec</td>
<td>Seconds</td>
</tr>
</tbody>
</table>

Dynamic text options can be concatenated with any text entered manually. For example, entering ‘Page $PageNo[1] of $TotalPages’ will result in a stamp like, ‘Page 1 of 5’ for example. The starting page number would be relevant to the number in the square brackets of the $PageNo[] dynamic text.

For examples on using dynamic text within a stamp please refer to the following sections of this user guide:
- Adding Bates Numbers
- Adding Page Numbers
5.5.2.3. **Font**

Debenu PDF Aerialist™ allows you to customize the appearance of your text stamp. Choose from System or Standard fonts, change the color, size and even the underline style used.

**Note:** that only one style can be set per stamp.

**Font type**
Choose from either 'System' or 'Standard' font types. System refers to the fonts present on your computer. Standard fonts (also known as Base 14) are those native in Acrobat/Adobe Reader. When using system fonts, it may be desirable to select the 'Embed font' option. This will embed the appropriate font in the PDF so that all users will see the font as intended.

**Note:** embedding the font in the PDF may result in an increase in file size.

**Font Size**
Set the size of your font.

**Font Color**
There are a number of standard colors to choose from. Click the drop down arrow to select a color. Choose ‘Other Color...’ to define a custom color. Colors are defined in the RGB color space.

**Underline**
Select from a number of underline types.

5.5.2.4. **Adding Bates Numbers**

Numbers in Bates format contain padded zeros. When applied, like page numbers, a Bates number increment by one throughout the document collection.

Bates numbers can be implemented using the $BatesNo[1] and $BatesTotalPages macros.

Bates Properties:

- **Fixed Length** - the fixed length (number of padded zeros) is configured in the options window. This setting is applied to both $BatesNo[1] and $BatesTotalPages variables.

- **$BatesNo** – the Bates Number Dynamic text allows inputting the starting number. $BatesNo[3], would mean that the Bates number start would be 3 instead of 1. The default is however set to always start with 1.

- **$BatesTotalPages** – this variable equals the total number of pages in the job from the starting number. If there are one hundred pages in the job, starting at point 00025, $BatesTotalPages = 000125
• **Applying in Batch** - When applying Bates stamps in batch, the Bates number increments over documents, the counter does not reset. When applying in batch you must stamp over a folder, not a selection of files otherwise the total number of pages will not be calculated correctly.

To add bates numbers:

1. Open the PDF document you wish to stamp.
2. Open the Stamp feature 'Plug-ins > Debenu PDF Aerialist™ > Stamp > Manage Stamps' or click on the ‘Manage Stamps’ toolbar button.
3. Click on the ‘New Profile’ button to add a new stamp profile.
4. With the new profile highlighted, click on the ‘Add Stamp’ button and select ‘Text’ to open the ‘Design your Text Stamp’ window.
5. Enter your Stamp name.
7. To set the value you wish the bates number to begin with, adjust the value within the square brackets. For example, to set the starting number on 9, set the macro to $BatesNo[9].

8. To set the length of the bates number, go to ‘Edit > Preferences > Debenu PDF Aerialist™ > Stamp’ and adjust the ‘fixed length’ to the desired length.
9. Change other properties for your text such as the layout, font style or action.
10. Click 'OK' to save your stamp and return to the main Stamp window.
11. Select the profile name so that the profile is highlighted.
12. Click the 'Stamp' button when you are ready to stamp your PDF document.

5.5.2.5. Adding Page Numbers

To add page numbers (i.e. “Page 1 of 10”):

1. Open the PDF document you wish to stamp.
2. Open the Stamp feature 'Plug-ins > Debenu PDF Aerialist™ > Stamp > Manage Stamps' or click on the 'Manage Stamps' toolbar button.
3. Click on the 'New Profile' button and a new profile will be added.
4. With the new profile highlighted, click on the 'Add Stamp' button and select 'Text' to open the 'Design your Text Stamp' window.
5. Enter your Stamp name.
6. In 'Text' type: "Page ".
7. Under Settings for 'Dynamic Text', select 'Page No. [ ]'. Click on the 'Insert' button to add $PageNo[1] to the 'Text'.
8. In 'Text' type after $PageNo[1]: " of "
9. Under Settings for 'Dynamic Text', select 'Total pages'. Click on the 'Insert' button to add $TotalPages to the 'Text'.


10. Change other properties for your text such as the layout, font style or action.
11. Click ‘OK’ to save your stamp and return to the main Stamp window.
12. Select the profile name so that the profile is highlighted.
13. Click the ‘Stamp’ button when you are ready to stamp your PDF document.
5.5.3. Image/PDF Stamp Settings

The Stamp feature allows you to apply image or PDF stamps to your documents.

**Note:** that image and PDF stamps share a number of similar properties. Some properties common to both are described in this section.

![Design your Image Stamp](image)

Designing Image Stamps
5.5.3.1. **Size**

Adjust this setting to resize your image or PDF. The adjustment affects both horizontal and vertical ratios.

**Note:** changing the scale of your image/PDF may affect image quality.

5.5.3.2. **Page Number (PDF Stamps only)**

Adjust this setting to choose which page number of the PDF document to use for the PDF stamp.

**Note:** The total number of pages is validated by the selected PDF.
5.6. Logging

To enable logging open the Stamps preferences from the ‘Edit > Preferences > Debenu PDF Aerialist™ > Stamp’ menu and ensure that the checkbox to enable logging is selected.

Logging preference

5.6.1. View Log File

To view the log file, from Acrobat menu, ‘Plug-Ins > Debenu PDF Aerialist™ > Stamp > Logging > View log’.

The log file records processing details. One log file is used to record details from all stamp processes. The general structure being:

- Data/Time
- File(s) processed
- Status
- Summary

=================================================================

Information : 19/06/03, 14:19:16
Processing Profile : LetterTemplate

Processing file : C:\temp\Introduction_3.pdf
Processed OK

=================================================================
Files to process: 1  
Files processed: 0  
Not processed files: 1  

--------------------------------------------------------------------------

Insert Text: Text is out of the page. Select another position or angle  
Insert Text: Text is out of the page. Select another position or angle  
Source Image file does not exist

If any unexpected errors occur, refer to the log file for debugging details. Please contact support@debenu.com if the problem persists.

**Note:** The log file will only be created if the "Enable Logging" option is checked in the Stamp Preferences.

### 5.6.2. Clear Log File

Selecting to run the Clear Log File feature will erase the log file saved previously.

To clear the log file, from Acrobat menu `Plug-Ins > Debenu PDF Aerialist™ > Stamp > Logging > Clear log`.
5.7. Configuring Stamp Preferences

Stamp preferences can be accessed from ‘Edit > Preferences > Debenu PDF Aerialist™ > Stamp’:

5.7.1. File Handling

- **Write stamp to new file** – Creates a new file to apply stamp on.
- **Enable logging** – Choose to keep a log of all the processes in a text file.
- **Ignore page rotations** – Choose to apply stamps similar to on an A4 size page even if the pages in a document are rotated.

5.7.2. Defaults

- **BATES fixed length** – Set the default length (zero padding) used with Bates numbers, i.e. entering 6 will stamp Bates numbers of format 000001, 000002, 000003 etc. Please see Adding Bates numbers for more details on Bates numbering.
- **Use Roman Numerals** – Choose to have the numbering in roman numerals, opting for the lower case or upper case. This option is unchecked by default.
6.1. Overview

The Links feature extends Adobe Acrobat’s tools for editing links in PDF files. Use the Links feature to copy, paste, edit, convert and check links. The Links feature set is essential for anyone distributing interactive PDFs that contain links across a single document or a collection of files. Using the checking reporting features you can check for any dead links, including web links and write the results out to a saveable report for cross referencing.

Some of the powerful features available in the Links feature are listed below.

Link Management:
- Link Alignment Palette
- Automate setting the appearances of links and notes
- Set Link Magnification
- Find and replace destinations in links, bookmarks and form fields
- Delete all or dead links only

Link checking:
- Identify broken links and bookmarks
- Validate links to websites and web pages
- Flash dead links for easy identification
- Dead Links Page Numbers

Link creation:
- Create links to specific pages based on numbers found in the page
- Automatically create links around specific words in the document
- Generate a Table of Contents on the fly

Use the Reporting function to create saveable reports in PDF or CSV format. Create reports on:
- All links
- Bookmark destinations
- External dependencies (web pages, links to other files)

Batch Processing:
- Copy links across multiple files
- Report on links and bookmarks across multiple files
- Convert and edit links in batch
6.2. Using Links

After installation, Link functions can be accessed via the ‘Plug-ins > Debenu PDF Aerialist 12 > Links’ menu item in Acrobat.

6.3. Export/Import Links

The Export/Import Links feature lets you export all links in a PDF or in a specified area or on a specified page and then import those links into another PDF.

As an example, if you have manually added 20 links to a PDF then discover an error in the PDF that requires it to be re-generated you can simply export all links from the PDF, re-generate the PDF and then import the links back into the new PDF.

6.3.1. Export Links

In order to export links you need to open the Export/Import Links window and select ‘Export’ in the ‘Action type’ section and then click on the ‘Browse’ button to choose a folder and filename for where the exported links should be saved.

The next step is to select the export options.

Export All Links on the Page
There are two options for ‘Export All Links on Page’. If you select ‘Scan’ then you will be able to choose from a variety of predefined page ranges such as ‘All Pages’, ‘Odd Pages’, and so on. If you select the ‘Range’ option then you will be able to specify the exact page range that you would like to use (e.g. ‘1,2,3-10,15’).

**Export Header/Footer**

This option enables you to export header and/or footer links the current page in the PDF. You can define the area of the header and footer by clicking on the ‘Select Area’ button. Only links found in the specified area will be exported.

### 6.3.2. Import Links

In order to import links you need to open the Export/Import Links window and select ‘Import’ in the ‘Action type’ section and then click on the ‘Browse’ button to choose the links position file that you wish to import.

**Import Options**

When importing a links position file you can specify
Link Checking

6.3.3. Show Dead Link Toolbar

Enable this toolbar to quickly navigate through broken links in the document with the Find Next, Find Previous and Flash Dead links on this Page commands.

The Dead Link Toolbar

6.3.4. Find Next Dead Link

Use this function to perform a search for dead links from the current page. The first dead links found are ‘flashed’ using a blinking effect. To find the next dead link, click this tool button again.

6.3.5. Find Previous Dead Link

This command will commence scanning backwards from the current page of the active document and find the next instance of a dead link. To continue scanning through the document, click either the ‘Find Previous’ or ‘Find Next’ button again.

6.3.6. Find Dead Links On This Page

This function will cause all dead links on the current page to flash for a few seconds, allowing for easy identification and correction of dead links.

To use this feature, click the ‘Find dead links on this page’ tool button on the ‘Dead Link Toolbar’.
6.4.  Link Management

6.4.1.  Show / Hide Link Alignment Palette

The Links feature allows you to align two or more links horizontally or vertically. The alignment options available are left, center, right, top, middle or bottom.

Please Note:
You cannot use the “Edit > Undo” function to undo link or note alignment. It is therefore recommended to save the file prior to aligning. If you are not satisfied with the alignment option you selected, you will be able to revert to the previous state by closing the file without saving it and then opening it again.

1. If the alignment palette is not already open, choose ‘Plug-ins > Debenu PDF Aerialist > Links > Link Management > Show Link Alignment Palette’, the alignment palette should then appear:

   ![Alignment Palette]

   Horizontal Alignment
   Vertical Alignment

2. Click the ‘Link Select Tool’ from the Debenu PDF Aerialist™ toolbar. Existing links will be made visible by a frame. Please note, you must select the tool button itself, not the dropdown menu.

3. Select the links or notes you wish to align. To select multiple links hold shift and click on links the desired links (for more information, see tutorials).

4. Click the appropriate alignment button in the alignment palette then selected links (or notes) should be aligned accordingly.

5. To close the alignment palette, click its “Close” button or choose ‘Plug-ins > Debenu PDF Aerialist > Links > Link Management > Hide Link Alignment Palette’

When using center or middle alignment, the centers of selected links or notes are averaged. When left-aligning, selected items are aligned using the leftmost item as a reference point; top alignment uses the topmost item as its reference, and so on.
6.4.2. **Set Link(s) Properties**

This feature is designed to update the visual properties of multiple links to share common attributes at the same time. Some usage examples include updating a selection of visible links to invisible or setting the magnification property to ‘fit width’ for all links in a particular document.

![Set Link Properties Dialog](image)

**6.4.2.1. Link Magnification**

The ‘From’ field designates which type of magnification(s) to alter to that specified in the ‘To’ field. If ‘All Magnifications’ is selected, all links within the ‘Apply To’ range will be affected.

In the ‘To’ field specify what magnification the desired links will change to. If no change is required, ensure that ‘Don’t Adjust’ is selected from the drop down combo box.
As an example, to change all links to ‘Fit Width’ in the document, select ‘All Magnifications’ in the ‘From’ field and ‘Fit Width’ in the ‘To’ field, ensuring that ‘All Pages’ is chosen from the ‘Apply To’ options.

6.4.2.2. Link Appearance

Link appearance settings are used to change the appearance of those links specified in the ‘Apply To’ range.

Link Type:
- Don’t adjust: the visible state of selected links will not change.
- Invisible Rectangle: links will be made invisible
- Visible Rectangle: links will be made visible (please refer to further appearance settings below)

The following settings are only activate if ‘Visible Rectangle’ is selected

Highlight: Set the highlight style for the link

Line Width: Set the width of the line bordering the link

Line Style: Set the line style (i.e. solid, dashed, underline) for the link

Color: Select the line’s color from the color palette

Lock: This is enabled for both visible and invisible links. Use it to lock the position of the link. To move a locked link, first unlock it.

To Use:
1. Select ‘Set Link(s) Properties’ from the Debenu PDF Aerialist™ toolbar. This will open the dialog seen below.
2. Populate the controls in this dialog by either:
   a. Activating the Link Select Tool and double clicking a specific link. The ‘Set Link(s) Properties’ window will inherit properties from the selected link.
   b. Adjusting each property manually on the dialog itself.
3. Using the mouse cursor, select the links whose properties you wish to update or specify the page range to update.
4. Click OK to update the properties.
6.4.3. **Find And Replace Destinations**

The ‘Find & Replace Destinations’ feature is a powerful feature for iterating through all links, bookmarks and form fields in the document and replacing incorrect or modified destinations. Links, bookmarks and form fields (buttons) typically have an action associated with them. Commonly this action is set to GoTo a page in a document, open a web link or open a file. In some cases the page, path or URL in the destination may change, requiring you to update the source file, a time consuming and tedious task.

Using the ‘Find & Replace Destinations’ feature in Debenu PDF Aerialist™, you can quickly step through links, bookmarks and form fields one at a time or change all in a single step.

To narrow your search, enter in the page number or destination to find and even filter by the type of action to be executed (i.e. GoTo, GoToR or URL). It is also possible to perform powerful conversions, for example converting URL to Open File links or GoTo named destinations into GoTo page actions.
Destination

**Search for:** Select the desired action type to search in. Action types to be searched within are:
- External files – only actions including Open File, GoTo Remote Page and GoTo Remote Named Destination will be scanned.
- WWW address – only Open Web Link (URL) actions will be scanned
- Page Number – only internal GoTo Page actions will be scanned
- Named Destination – actions of type GoTo Named Destination are scanned. This will find both internal and external Named Destinations.

**Find all of this type:** By checking this option Debenu PDF Aerialist will ignore any parameters specified in the *Find what* criteria. Use this option to simply iterate through links, bookmarks and form field actions that are of the type specified in the *Search for* drop down box.

**Find what:** Enter a value here to narrow your search further. For example entering ‘5’ with type ‘Page Number’ selected will only find destinations to page 5 in the document. Entering ‘www.debenu.com’ with type ‘WWW Address’ selected will find web links with ‘www.debenu.com’ in the URL.

**Replace with:** This text field should be used in conjunction with the ‘Find what’ box to alter any errant destinations. For example, searching for ‘5’ with replace ‘23’ and type ‘Page Number’ selected will alter all destinations pointing to page 5 to page 23. Searching for ‘P1.255’ with replace ‘P2.asd.55’ and type ‘Named Destination’ selected will replace the ‘P1.255’ with ‘P2.asd.55’ in any named destination found that contains ‘P1.255’.

**Options:** This contains a summary of the preferences selected in the ‘Options’ box.

### 6.4.3.1. Options

The options group can be hidden or made visible by toggling the ‘Less’ or ‘More’ button. This group provides extra criteria to refine your search.

**Search:** Choose between ‘Up’ or ‘Down’ to change which direction through the document to iterate.

**Match case:** The find text must match the exact case of the link destination. This does not affect page number destinations.

**Match complete string:** Only destinations that match the entire text as specified in the ‘Find’ field will be found.

**Search in links:** If checked, the search will include destinations found link actions.

---

5 If the option to match complete string is selected, the named destination must match the find criteria exactly. If the exact match is found, the named destination will be replaced with the value specified in the ‘Replace with’ field.
**Search in bookmarks:** If checked, the search will include destinations within bookmark actions.

**Search in form fields:** If checked, the search will include destinations found within form field actions.

**Convert to:** This feature is dynamic and changes depending on the type of action searched for. Please refer to the table below for more information:

<table>
<thead>
<tr>
<th>Type</th>
<th>Convert to</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External File</td>
<td>Web Link</td>
<td>Open file actions are converted an Open web page action. Destinations containing absolute paths are not converted.</td>
</tr>
<tr>
<td>WWW Address</td>
<td>Open file</td>
<td>Open web page actions are converted to open file paths. Only destinations with relative paths are converted.</td>
</tr>
<tr>
<td>Page Number</td>
<td>Named Destination</td>
<td>GoTo page actions are converted named destinations. New named destinations are created in the document itself to coincide.</td>
</tr>
<tr>
<td>Named Destination</td>
<td>Page Number</td>
<td>Actions set to GoTo a Named Destination are converted to GoTo Page. Named destinations are not removed from the document itself. User’s should consider using Acrobat’s PDF Optimizer feature to remove unused named destinations.</td>
</tr>
</tbody>
</table>
6.4.4. Set Base URL

Set the Base URL for links within a document.

To access the ‘Set base URL dialog, choose ‘Plug-ins > Debenu PDF Aerialist™ > Links > Set Base URL’

Setting base URL Dialog

- If ‘Set base URL for document’ option is selected, then:

  This function sets the base URL for a document. If the Base URL changes, all other links will be updated to reflect the change.

- If ‘Append URL to all relative web links’ option is selected, then,

  The specified URL is appended to all web links that do not use absolute addresses.

Example 1:
- URI link in the document is “./debenu_pdf_search.asp”
- BaseURL is http://www.debenu.com/
- Convert URI web links option changes to -> http://www.debenu.com/debenu_pdf_search.asp (note the ‘./’ is removed)

Example 2:
- URI link in the document is “..//debenu_pdf_search.asp”
- Base URL is http://www.debenu.com/pdfsearch
6.4.5. Create Page Links

This feature is designed to automatically create links around numbers in the document. Numbers suspected to designate page links will be set to execute a GoTo Page action where the page number will be determined by the value of the number found. For example, if text is found containing the number ‘4’ then a link pointing to page 4 of the document will be created around the text ‘4’.

Note: If a number is found in the scanned area and the value of this number exceeds the number of pages in the document then a link will not be created. For example, the number ‘160’ is found but there are only 125 pages in the document, no link will be created.

To Use:

1. Open the PDF file containing the numbers you wish converted to page links.
2. With the mouse cursor, draw a rectangle around the area of the page you want scanned. Link suspects will be highlighted. If no area is drawn then the entire page will be scanned for potential page links.
3. Set the desired appearance (visibility, color etc.) and magnification options.

Create page links dialog with created links visible.
4. Select the desired page range to scan and create links from. If a specific area of the page was scanned then the equivalent area will be scanned on all pages within the specified page range.
6.4.6. Create Keyword Links

This feature allows links to be dynamically created based on specific text found within the document. Links can be set to execute a variety of actions such as open URL or external file, go to a specific page or named destination or even the next instance of the word in the document. The font color of the found word can also be set automatically, enabling a fast and efficient way to visually indicate links and maintain specific style requirements.

Create Keyword Links dialog

To Use:

1. Open the PDF file containing the text you wish to scan for keywords.
2. From the 'Links' tool button menu select 'Create Page Links'.
3. Enter the desired text to search for. If 'Exact phrase' is not selected then any words containing the search text at the beginning, middle or end will also be found. For example, searching for 'pre' without exact match selected will produce links for, 'previous' and 'apprehend.'
4. Set the 'Action Type' and destination as required.
5. Set the link appearance properties as desired.
6. Click ‘Find’ to locate the next instance of the search text.
7. To create this link, click ‘Replace’ or ‘Replace all’ to find and create all keyword links in the document.

**Note:** It is only possible to search forwards through the document. Searches commence from the current page.

### 6.4.6.1. Regular Expressions

Create Keyword Linking by regular expression enables users to automatically generate links for variable words (e.g. a part number or invoice). So for example a company might have a datasheet with various part numbers and the part numbers might have their own corresponding PDF files. The regular expressions let you capture all the different part numbers in the doc without having to explicitly list every single part number and it can then link to the corresponding file or web page.

More information about regular expressions can be found here:

- [Regular expression](Wikipedia)
- [RegExr](use website for learning how to create regular expressions)

Regular expressions are a powerful tool for dynamically finding variable keywords. As an example the below regular expression will find the following keywords dynamically: “split”, “splitting”, “splitted” and “splits”.

The regular expression used in this example is:
```
\bsplit\(ting|ted|s?\)\b
```
6.4.6.2. **Append Keyword Links to URL**

This option will append a keyword onto the end of a URL. This is a powerful feature and can be used with the regular expression support in the Create Keyword Links feature to generate dynamic URL’s based on found keywords.

For example, if you wanted to create keyword links in a PDF that used the found keyword as a search term in Google, then this would be very easy.

To Use:

1. Select the action type ‘Open web link’
2. Add in the URL that you wish to use (e.g. https://www.google.com/?gws_rd=ssl#q=)
3. Select ‘Append found keyword to above URL link’
4. Click on OK and then create the keywords
6.4.7. **Table of Contents**

The Table of Contents (TOC) builder is a feature of Debenu PDF Aerialist™ only. It is used to build a listing of files and/or sections of files and to control its layout. This list is visually displayed as either new pages on a specific PDF or a new file.

The TOC Builder can be opened from the ‘Links’ tool button group or via Acrobat’s plug-ins menu. If no document is open in Acrobat, only a Master TOC can be built. To build a document TOC, first open the source PDF.

![Table of Contents dialog](image)
Type

There are two **types** of Table of Contents that can be built using the TOC builder.

- **A Document Table of Contents**
  - A Document Table of Contents can be created from existing bookmarks or example headings in the active document. Each entry in the table of contents will be linked to the corresponding section in the active document.

- **A Master Table of Contents**
  - A Master Table of Contents is built from many files and can be created from existing bookmarks, example headings or document information fields such as Title, Subject, or Filename.
  - If a Master Table of Contents is selected, you must also define the source files to be processed. To do this, click ‘Files…’

![File list for Master TOC.](image)
6.4.7.1. Text Source

The options in this list determine where to gather the text used for each entry in the Table of Contents.

- **Bookmarks**: The Table of Contents will be built based on bookmarks already defined in the document. For a master table of contents the table of contents will be concatenated in the same order as the files are processed. Link actions will be inherited from the bookmarks.

- **Headings**: The Table of Contents is built dynamically from distinct section headings in the document. Headings styles can be defined by a combination of font, size, color, indentation and text.

- **Filename**: The table of contents will be based on the filename as defined by the selected files. This option will use write filename only and not the full path. Link actions will be set to open the external document using either an absolute or relative address.

- **File path**: The table of contents will list the full path and filename of the files as set. Link actions will be set to open the external document using either an absolute or relative address.

- **Title**: The table of contents will list the title (as set in the document properties) for each file of the selected files. Link actions will be set to open the external document using either an absolute or relative address.

- **Subject**: The table of contents will list the subject (as set in the document properties) for each file of the selected files. Link actions will be set to open the external document using either an absolute or relative address.

- **Author**: The table of contents will list the author (as set in the document properties) for each file of the selected files. Link actions will be set to open the external document using either an absolute or relative address.

- **Custom**: Using the custom option will allow you to define a combination of static and dynamic text such as filename, title, subject, creation date, file size etc. The table of contents will list the subject (as set in the document properties) for each file of the selected files. Link actions will be set to open the external document using either an absolute or relative address.
6.4.7.2. Defining Heading Styles

Automatically generate a Table of Contents based on the font styles and layout used in your PDFs. After setting the desired combination of attributes for each level in the TOC, Debenu PDF Aerialist can quickly scan one or more PDF files to build the Table of Contents for each document.

To define headings:

1. Select the Master or Document from the ‘Type’ drop down.
2. Select the ‘Headings...’ and click on “Define...” to set the parameters.
3. To set individual Heading styles please follow the instructions in section 5.5 Building Bookmarks.

The Select Heading Levels Dialog

6.4.7.3. Text Format

The layout of the final TOC is completely customizable. It is possible to customize the font used for the TOC as well as the indent for each line, font size and color. The title of the TOC is static text and can be customized as required. To edit any of these settings, click the associated button and enter in new settings as desired.
Options

Use these settings to control some important minor options:

- **Section Numbers**: Add, remove or ignore the presence of section numbers in the TOC.
- **Line Spacing**: Set line spacing between TOC entries to either single, 1.5 or double.
- **Links**:
  - Relative: Links will be created using relative addressing provided that the final destination of the TOC is specified.
  - Absolute: Links will be created with absolute addresses.
- **Magnification**: Links in the TOC will maintain the view as set in this dialog.
- **Separator**: Entries in the TOC are justified. Select the desired separator (dots, hyphens, underscores, none) to control what character will separate the text from it’s associated page number.

6.4.7.4. **Destination**

The settings here control whether the Table of Contents will be inserted into the open document or a new file. If a new file is created then it is recommended you specify the full path and filename especially if you wish to use relative rather than absolute links.

6.4.7.5. **Preview**

The Preview feature enables user’s to produce a soft proof of the Table of Contents before actually creating. At preview stage user’s can edit any entry in the TOC and well as add new items.

To regenerate the preview thumbnail and any changes made to the TOC, simply hit refresh.
6.4.7.6. **Saving & Loading Settings**

Settings can be saved for reuse using the ‘Save Settings’ & ‘Load Settings’ buttons. This will save the type and layout for the create TOC dialog. These settings can be saved and reused again as necessary.
6.5. Delete Links

The Links feature can be used to delete all links or dead links only from a document. To use this feature, navigate from the Acrobat plug-ins menu to ‘Plug-ins > Debenu PDF Aerialist™ > Links > Delete Links’. There are two options available, delete all links or only delete the dead links in the PDF file.

Deleting the links in the document.

**Note:** Be careful when using this function, as Acrobat cannot undo the deletion of links. If you have accidentally deleted them, the only way to retrieve them is to exit the document without saving, and re-open.
6.6. Reporting

6.6.1. Report on Bad Actions

This feature searches an entire document and produces a list of all actions (link or widget annotations) and bookmarks that are bad. This report can be executed in batch using Acrobat’s batch processing engine. Each item in the report has a link to where the problem is located.

To use, select ‘Plug-ins > Debenu PDF Aerialist™ > Links > Create Report On > Bad Actions’.

---

**Link Report**

Report on bad actions from:
/C/docs/documentation.pdf

Number of pages: 4
Document action: none.

Bookmarks:
:1.3 System Requirements -> Page number in this file is out of range.
:Index -> Page number in this file is out of range.

Links:
page 1 A link must contain at least a Destination or Action or Additional Action.
page 1 All of those are missing from this link.
page 1 Page number in this file is out of range.
page 1 Page number in this file is out of range.
page 2 Web link address is bad.
page 3 Web link address is bad.

Sample report generated on all bad actions
6.6.2. **Report on Bad Bookmarks**

This function produces a report detailing broken bookmarks. Bookmarks are deemed broken if the target page, view, named destination, file or URL is unavailable.

To use, click 'Plug-ins > Debenu PDF Aerialist™ > Links > Create Report On > Bad Bookmarks'.

```
Link Report
List of broken bookmarks from:
/C/docs/documentation.pdf

:1.3 System Requirements -> Page number in this file is out of range.
Index -> Page number in this file is out of range.
Visit Us -> Web link address is bad.
```

Sample report generated on bad document bookmarks
### 6.6.3. Report on All Links

Use this feature to produce a report on all the links present in the document. The report identifies both valid and broken links. Broken links are prefixed with an 'X' symbol to assist identifying broken links and missing destinations. Note, this report does not report on bookmarks.

To use, select 'Plug-ins > Debenu PDF Aerialist™ > Links > Create Report On > All Links'

<table>
<thead>
<tr>
<th>CONTENTS</th>
<th>INDEX</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

#### Link Report

All links details:

/C/docs/documentation.pdf

<table>
<thead>
<tr>
<th>Links:</th>
</tr>
</thead>
<tbody>
<tr>
<td>page 1 Link to - page 1</td>
</tr>
<tr>
<td>X page 1 - Action is null.</td>
</tr>
<tr>
<td>page 1 Link to - page 3</td>
</tr>
<tr>
<td>page 1 Link to - page 3</td>
</tr>
<tr>
<td>page 1 Link to - page 3</td>
</tr>
<tr>
<td>X page 1 Link to - - Page number in this file is out of range.</td>
</tr>
<tr>
<td>page 1 Link to - page 4</td>
</tr>
<tr>
<td>page 1 Link to - page 4</td>
</tr>
<tr>
<td>page 1 Link to - page 4</td>
</tr>
<tr>
<td>page 1 Link to - page 4</td>
</tr>
<tr>
<td>X page 1 Link to - - Page number in this file is out of range.</td>
</tr>
<tr>
<td>page 1 URL - <a href="http://www.artspdf.com/">http://www.artspdf.com/</a></td>
</tr>
<tr>
<td>X page 2 URL - http://www.this_is_an_incorrect_url.com/ - Web link address is bad.</td>
</tr>
<tr>
<td>X page 3 URL - http://www.faulty_link.com/ - Web link address is bad.</td>
</tr>
</tbody>
</table>

Sample report generated for all the links
6.6.4. **Report on External Dependencies**

Selecting this function will produce a report containing a listing of all external files and URLs that are referenced by bookmarks, link or widget annotations. URLs in the list are active and can be clicked, allowing you to quickly go through the whole list for verification.

Examples of external dependencies include external files (PDF or other) and URLs.

To use, select ‘Plug-ins > Debenu PDF Aerialist™ > Links > Create Report On > External Dependencies’

---

**Link Report**

**List of external dependencies from:**
/C/docs/documentation.pdf

**Bookmarks:**
Visit Us - URL:www.bad_web_addresss.net

**Links:**
page 1  - URL:http://www.artspdf.com/
page 2  - URL:http://www.this_is_an_incorrect_url.com/
page 3  - URL:http://www.faulty_link.com/

Sample report generated on external dependencies
### 6.6.5. Report on Selected Link

This feature will generate a low level report on the structure of the selected link or annotation. This feature is intended to be useful to experienced developers who are familiar with the PDF Specification. This report may offer an explanation as to possible strange (unexplained) behaviors in a link.

To use:

1. Select the Debenu PDF Link Tool in the toolbar.
2. Using the Debenu PDF Link Tool select a single link or annotation.
3. Click ‘Plug-ins > Debenu PDF Aerialist™ > Links > Create Report On > Selected Link or Annot’

**Note:**

A GoToR link to an external file that references a page number or name that does not exist will cause Adobe Acrobat to open the external file to page one. Because the user goes somewhere when a link is clicked, the link would not seem to be broken. But, the link is broken, and Debenu PDF Aerialist will flag this as a bad link.

If you find such a link and the desired destination happens to be page one anyways, you can leave this alone. If, however, you are using a named destination and the intended destination is later moved to another page along with the named destination, the link will still point to page one because it is using a name that does not match any name found in the document.

You may occasionally get the message that the routine went "too deep" and an object will not be enumerated. This is often the case with objects that refer to each other in a circular loop of "next" and "previous" objects. This setup is valid, and is sometimes required by the spec, but Debenu PDF Aerialist will not provide details about objects it knows are of this type, and will stop after a certain number of iterations if it unknowingly starts reporting in a loop.
Link Report
Created By
/C/docs/documentation.pdf

Annot is broken:
A link must contain at least a Destination or Action or Additional Action.
All of these are missing from this link.

CosDict:
/H -> /I
/Type -> /Annot
/Rect -> CosArray [len = 4]:
   90
   654.6959
   524.52
   670.4641

/Border -> CosArray [len = 3]:
   0
   0
   0

/ES -> CosDict:
/W -> 0
/Type -> /Border
/S -> /S

/Subtype -> /Link
6.6.6. **Count Links**

Count the number of links, widgets and bookmarks in the active PDF document. And display the number of each that is broken.

To use, click 'Plug-ins > Debenu PDF Aerialist™ > Links > Create Report On > Count links’

**Link Report**

List of broken bookmarks from:
/D/Users/Desktop/GenerationX/UserGuides
df

No bookmarks found.
6.7. Configuring Link Preferences

The Links feature preferences can be accessed from ‘Edit > Preferences > Debenu PDF Aerialist™ > Links’:

![Links Preferences Dialog]

- Count links without checking for bad links
  - Selecting this option will confirm that the links total will not include bad links.

- Check named destination in external file.
  When this option is:
  - Selected, then the application will not check for named destinations.
  - Not selected, then application will check named destinations.
• Check web links
   When this option is:
   - Selected, the application checks for the web links in the document. The web checking features checks for hyperlinks for the major HTTP protocol.
   - Not selected, the application does not check for validity of web links.

• Make reports landscape layout
   When this option is selected, all the report generated will be in landscape format instead of the portrait format.

• Use CSV database output
   When this option is selected, the reports generated get saved as the CSV (Comma Separated Value) file format, which is often used to exchange data between disparate applications.

• Report on web links
   When this option is:
   - Selected, then the reports generated will include web checking.
   - Not selected, the reports will not include web checking.

**Note:** Web checking will only be activated if the ‘Report on web links’ is selected in Links’ preferences.
6.8. Additional Link Features

6.8.1. Multiple – select and drag links

The Links feature of the Debenu PDF Aerialist™ will add a button to your toolbar that allows you to select multiple links. Click on a link, hold down shift, and click on another link. It works just as you would expect to be able to select multiple links. You can also use the "Select All" menu to select all links on a page.

Once you have a group of links selected, you can drag them together to move them, align them using the alignment palette, or cut and paste them using the standard clipboard commands.

Select and drag links
6.8.2. Cut and paste links

After you have selected one or more links with the Links feature, you can use standard clipboard commands under the Edit menu to cut and paste links. You can quickly make multiple copies of the same link if you need several links to all be the same size. You can also paste onto other pages or into other documents.
6.8.3. **Paste links onto multiple pages or multiple files**

Using the Paste Multiple command, you can paste links from the clipboard throughout a document, or you can choose a starting page number and an ending page number. You may also select whether the links will be pasted on even, odd, or all pages. If you choose the batch button, you can paste links onto the selected page range for a batch of documents.

To use:
1. Activate the link selection tool
2. Select the desired links to copy
3. Select copy from the Edit > Copy menu
4. Select ‘Paste link(s) across multiple pages...’ from the Debenu PDF Aerialist™ Links menu.
5. Enter the desired page range to copy the links across.
Debenu PDF Aerialist includes an imposition feature which allows you to perform both n-up and step-and-repeat impositions on the current PDF document. To launch the imposition tool click on the button on the Acrobat toolbar or select “File > Debenu PDF Aerialist > Imposition...” from Acrobat’s Menu.

### 7.1. Imposition Layout

This window allows the user to setup how their PDF will be imposed and which options will be applied when the new PDF is created.

#### 7.1.1. Horizontal/Vertical copies

![Imposition Layout Window](image-url)
These values determine how many copies will be created when ‘Step and Repeat’ is selected or how many pages to impose to a single page if using ‘N-Up’ mode. The default values of 2 mean that the new PDF will have 2 pages across and 2 down.

7.1.2. **N-Up**

When imposing a multi-page PDF, selecting N-Up means that n-number of pages will be placed across and down on the new PDF page. If there are fewer pages in the original PDF than are required to fill the imposed page(s) then a blank page (or pages) will appear so that a full imposed PDF is created. To create multiple copies of a 1 page PDF use Step and Repeat instead.

7.1.3. **Step and Repeat**

This option causes each page of the current PDF to be copied both across and down on the new page based on the horizontal and vertical copies settings.

7.1.4. **Add crop and registration marks**

When selected this option will add both crop and registration marks the imposed PDF. The new page size will be automatically increased to accommodate the marks.

7.1.5. **Add gutter**

When this checkbox is selected, a gutter will be inserted between the inner joins of the imposed pages. When a bleed box defined, the joined pages will align at the edge of their bleed box. If no bleed box is defined then the distance between the pages will be 6mm or 0.24 inches.
8.1. Overview

Mail merge is a term that describes the production of multiple (and often large numbers of) documents from a single template form and a structured data source.

The Mail Merge feature in Debenu PDF Aerialist enables you to merge data from spreadsheets or text files into PDF form template and save the output a unique PDF file. It is a great tool for a myriad of mail merge, forms filling and other variable data printing applications.

- Merges variable data with PDF forms
- Uses text delimited data files from spreadsheets and text files
- Save to single or multiple PDFs

Mail merge is a convenient way to produce tens, hundreds or thousands of personalized letters, bank statements, invoices, pre-addressed envelopes and many other uses with just a few simple steps.

![Figure 1 Mail Merge Dialog](image)

Figure 1 Mail Merge Dialog
8.2. **Using Mail Merge**

Mail Merge enables quick generation of customized PDF files based on a given data source.

Please note that a PDF with form fields must be open in Adobe Acrobat before the Mail Merge feature can be used.

8.2.1. **Data Source Options**

Mail Merge supports the use of text files and CSV files as data sources.

Supported delimiters include:

- Comma
- Tab
- Semi-colon
- Space

Single-quote and double-quote qualifiers are also supported for handling strings from the data source.

You can determine which delimiter and qualifier should be used by opening the text files and CSV files in plain text editors and examining the data.

8.2.2. **PDF Output**

The end result of the mail merge is that you should have one or more new PDF files filled with data. In the PDF Output section on the Mail Merge dialog you can specify the folder in which the newly generated PDFs should be placed.

It is possible to specify if each record from the database should be contained within its own PDF or if all records should be added to the same PDF as different pages.

You can also control the naming of the generated PDFs by providing your own custom name or specify a form field from the data source that should be used as the filename.

8.2.3. **Advanced Options**

Mail Merge includes several advanced options to give you greater control over the mail merging process.

- **Print Records**
  - All – processes all records from the data source
  - Range – processes the specified range of records from the data source

- **Page Range**
  - All
- **Range**

- **Form Field Options**
  - **Auto-map Fields** – automatically maps fields between data source and PDF template
  - **Highlight Fields** – highlights certain form fields based on form field value
  - **Flatten output PDF documents** – removes form fields but leaves the data displayed on the page in the PDF
  - **Make all form fields read-only**
  - **Remove “.0” from the end of numeric values**
  - **Format dates as** – convert data format to alternative data format
9.1. Frequently Asked Questions

This section provides some answers to common questions and details on what to do if a problem is encountered concerning the following:

**BOOKMARKS**
- Blank Bookmarks
- Unwanted Bookmark Text
- The Line Indentation Tool doesn’t work
- Batch Processing the Build Bookmarks function
- Color changes not shown in Add Bookmark’s preview pane
- Bookmarks not displayed in Add Bookmark’s preview pane

**CONTENT ASSEMBLY**
- Control File error message
- Files on a network drive

**STAMP**
- Wrong stamp applied
- The preview pane

**PRODUCTIVITY**
- Tool and Toolbar Limits
- Degrading Performance
- Missing Predefined Tools
- No Tool Manager
- Folders not read
- General

**Blank Bookmarks**

“Sometimes when I use the Build Bookmarks function, it produces bookmarks with no text.”

This problem is caused by the text in the document not meeting the property requirements set in Build Bookmarks. If the text does not meet the properties then no bookmarks will be created at that level.

For example: If a Level 2 bookmark is created in a section of the document where the properties for a Level 1 bookmark aren’t met, the Level 2 bookmarks will be created under a blank Level 1 bookmark.
Unwanted Bookmark Text

"The text of my bookmarks contains other unwanted text."

The Bookmarks feature processes text by lines of text, and produces a bookmark out of the whole line of text.

For example, if you specified "sales" in the text mask field, and your PDF document had a line in it with the text:

“and so to conclude, our company had no major sales this month”

The whole line of text will be turned into a bookmark.

For some cases it is better to modify your selections, possibly including some text masking, or adding more selection criteria (e.g. Font Size, Color, etc.). Other cases might require cleaning up, either manually in Acrobat, or via the Find/Replace function.

The Line Indentation Tool doesn’t work

"I am using the Line Indentation tool to select specific text but the Bookmarks Build feature is not creating bookmarks from them”.

The line indentation tool selects text from its line indentation, not it’s position. Line indentation and position are different properties, and sometimes selecting a section of text will not convert it into a bookmark. To work correctly the text’s line indent must be included within the selection.

For the following examples, the document’s Line Indent will be shown with a red line.

Example number 1 uses the incorrect way to select text, Example 2 uses the correct way.

1. Example Text incorrect, misses the line indent

2. More Example Text correct, the line indent is included.

PDF files created from Microsoft Word, text with the alignments of Justified, Center, Right, and Left all have the same default line indent position, even though they are positioned differently on the page. For example, the following texts have the same line indentation point:

This Left aligned text has the same line indentation as....

...this is Center aligned text, and the line indentation is also the same for...

...Right aligned text, and the same for...

...This text, which has its alignment set as Justified.
As an example of line indentation, try creating bookmarks using the line indentation property from the following dot points, or bullets. When dot points are created (in MS Word) the line indentation is changed also, so each different level of dot points has a different line indentation. Create a bookmark level for each dot point.

- Bookmark Level 1
  - Bookmark Level 2
  - Bookmark Level 3
- Bookmark Level 4
  - Bookmark Level 5

Also, try playing around with the tolerance to see how that effects the text selection and the resulting bookmark creation.

**Batch Processing the Build Bookmarks function**

"I can’t use the mouse to select text in the Build Bookmarks function when setting up a Batch Process."

Acrobat’s Batch Process does not allow the user to interact with anything else in Acrobat whilst it is operating. This means that you cannot use the mouse to select text in the Build Bookmarks function when creating a batch sequence in the Batch Process. To work around this create the settings you require and Export them to file before opening Batch Processing. Once you open Batch Processing, simply import them in using the Import button.

**Color changes not shown in Add Bookmark’s preview pane**

"I have specified a font color for my bookmark text, yet it is not shown in the preview pane of the Add Bookmarks function."

Currently the preview pane does not display bookmark font color. Once you add the bookmarks to the document you will see that the bookmarks have your specified font color.

**Bookmarks not displayed in Add Bookmark’s preview pane**

"I have a document already containing bookmarks, but the Add Bookmarks preview pane does not display them."

The Add Bookmarks function is not an editing tool (for bookmark editing we recommend you use the Find/Replace tool). As such, it does not display any bookmarks that are already on the document.
Control File error message

"When I attempt to merge PDF files using the Control File method I get an error message. What does the error message mean?"

Typically you may get errors such as "Control file is malformed" or "The file ‘x.pdf’ doesn’t exist”. The reason for these errors may be one of the following:

• You have moved or deleted a PDF file.
• You have spelt the pathname of a file incorrectly.
• You have used spaces instead of tabs.
• You used quotes before/after the pathname.

Please see Using a control file for the correct structure of a control file.

Files on a network drive

"Can the Content Assembly feature work if all my files are stored on a network drive?"

Yes, Content Assembly features will work even if the files are stored on a network drive. The only exception is the control file function for the merge feature. The merge will not work if the control file is stored on a network drive, it must be stored locally.

Wrong stamp applied

I’ve stamped my document and it was the wrong stamp. I need to remove the stamp, how do I do it?

To remove a stamp, select Undo Stamp from the Stamp tool button or ‘Plug-ins > Debenu PDF Aerialist™ > Stamp’ menu. Stamps can only be removed using the undo feature if the document has not been saved. If the document has been saved, use Acrobat’s built in editing tools to remove unwanted stamp objects.

The preview pane

I really like using Stamp feature but switching between profiles in the Stamp Management dialog results in the application taking some time to refresh the preview pane. How can I improve this?

The preview pane is designed to offer a very accurate representation of how the output document will appear. It’s possible to navigate through pages in a document to verify your stamp settings. Consequently clicking on multiple stamps requires the preview pane to refresh at every click. For large documents or profiles with many stamps we recommend that you uncheck the preview option to minimize unnecessary processing. If you wish to preview the output, simply recheck it.
Tool and Toolbar Limits

"Are there any limits to the number of tools or toolbars I can create?"

For performance reasons, there is a limit of 20 toolbars loaded at a time and a limit of 100 tools per toolbar. If you want to keep your tools or toolbars, but keeping them will exceed the limit, use the export feature to save those tools or toolbars that you don't regularly use and just import them when needed.

Degrading Performance

"I have created a custom tool, but every time I try to use it, it seems to degrade the performance of Debenu PDF Aerialist’s Productivity feature."

If you create a tool with many multiple commands (e.g. 200), the performance will decline based on the system specifications. You should rethink the way in which you are performing the task so as to utilize less commands.

Missing Predefined Tools

"I've looked at your list of tools and not all of them are in my predefined toolbar?"

Some toolbar buttons have been removed for Acrobat 5.0/6.0 compatibility.

No Tool Manager

"I can’t see the 'Add or Remove Tool – The Tool Manager' button anywhere. It's not even under the Debenu PDF Aerialist™ menu item. Where do I find it?"

For this button to display you must have an existing Debenu toolbar (not including the Debenu PDF Aerialist™ toolbar). You have the option of either creating or importing a new toolbar. Remember to restart Acrobat after creating or importing the toolbar and ensure that the toolbar is not hidden for the toolbar button to display.

Folders not read

"When I open the watched folders dialog I get a message 'One or more watched folders are not read'. What does this mean?"

A sequence, associated with one or more of the watched folders, has been deleted. As a result, the watched folder has been removed from the list.

General

"I am having a problem with Debenu PDF Aerialist™ and it is not covered in this FAQ. What can I do?"
• Visit our Debenu Forum (http://forums.debenu.com/) to talk with Debenu technical support and other Debenu product users. Search the existing discussions and/or post your own questions. Each Debenu product has its own dedicated discussion area.

• Email support@debenu.com and one of our team will reply as soon as possible.

9.2. Forum


9.3. Known Issues

Known issues of Debenu PDF Aerialist™:

LINKS
• When using the Productivity feature for All Links Report, Bad Actions Report, Bad Bookmarks Report, Count links report and External Dependencies Report commands, no reports are created. However, these functions will work with Acrobat’s Batch Processing feature.
• Creating a report on ‘External Dependencies’ the report on external dependencies does not generate in CSV format, even when the option ‘Use csv format’ option is checked in Preferences.

STAMP
• A Text Stamp containing a broken (dashed) line to outline the font characters will be invalid.
• When creating a new Profile, the drop down menu from Debenu PDF Aerialist™ tool button is not repopulated with new profiles. Once Acrobat is restarted the list is displayed correctly.
• Debenu PDF Aerialist™ only supports stamping JPEG and TIFF images in Acrobat 5.0. To stamp other image file formats, we recommend first converting the image to PDF then stamping as a PDF stamp.

LAYERS
• Attempting to create layers with a secured PDF document may force Acrobat to quit.
• The preference ‘Remember Windows Position’ does not work under Windows 2000.
• Layers created from pages cannot be deleted if the preference ‘Group objects in page layer’ is not selected.
• New pages or documents use the media box for the page size. For more information please contact support@debenu.com
9.4. Updates

To ensure you are up-to-date with the most recently released bug fixes and new features; check that you have the latest version of Debenu PDF Aerialist™ installed. To check if your version is the latest:
3. Choose Product Info and click Updates.

9.5. Premium Upgrade Protection

At times Debenu will release updates that may include significant enhancements to the product. It is recommended that you take up Premium Upgrade Protection to be entitled to free upgrades (whether it be minor or major release versions) over a period of 12 months from the initial purchase.

Premium Upgrade Protection can be purchased at the same time you buy the associated product. If you wish to renew a subscription, or if you wish to purchase a subscription for a product you already own, please contact your reseller or Debenu directly at sales@debenu.com
9.6. **Technical Support**

Before contacting us please read the complete Troubleshooting section as the answer to your problem may be found in the FAQs or on the Debenu Forum. To contact Debenu Technical Support, please e-mail support@debenu.com and supply the information below to help us replicate the problem you are experiencing.

a. The exact version of Debenu PDF Aerialist™ you are using (this is located by running Debenu PDF Aerialist™, and then clicking Help > About Third-Party Plug-Ins > Debenu PDF Aerialist™). Please also specify whether you are using a demo or full registered version.

b. Whether or not you purchased Maintenance with Debenu PDF Aerialist™. If you did purchase Maintenance, please supply your Debenu PDF Aerialist™ serial number.

c. The exact version of Adobe Acrobat you are using (this is located by running Adobe Acrobat, and then clicking Help > About Acrobat).

d. Whether you are running it on a PC or Macintosh and the exact version of the Operating System you are using.

e. The amount of free disk space remaining.

f. The CPU speed and amount of RAM for the system on which Debenu PDF Aerialist™ is running (e.g. Pentium 233 MMX, 32MB RAM).

g. Any other programs that are running at the time of the error (e.g. Outlook, Internet Explorer, etc).

h. All error messages that were displayed when the error occurred.

i. The exact series of steps that led to the error.

j. Whether this error occurs on every PDF document or just a selected amount. If possible, please send us a sample of the file that caused the error.

k. What program was used to create the PDF documents? E.g. Acrobat Distiller, Crystal Reports, Zeon PDF Driver, etc.

---

**Feedback**

If you have ideas and suggestions on how we could improve Debenu PDF Aerialist™, we would love to hear your thoughts. Please send them to contact@debenu.com

**Legal Notes**

Acrobat and Exchange are registered trademarks of Adobe Systems Incorporated. Debenu PDF Aerialist™ is Copyright © 2014 Debenu.
A
Activate, 9
Add Bookmarks
   Add, 81
   Add to list, 76
   Change bookmark properties, 76
   Collapse bookmark option, 81
   Copy from PDF, 80
   Edit, 76
   Import and export, 81
   Insert option, 81
   Move in list, 80
   Preview pane, 75
   Remove from list, 79

B
Batch Processing, 35
   Bookmarks, 38
   Import Tools, 38
   Links, 40
   Sequence. See Sequence
   Split, 39
   Stamp, 40
Bookmarks
   Add. See Add Bookmarks
   Batch processing, 38
   Build. See Build Bookmarks
   Customized toolbar button, 31
   Delete, 95
   Features, 54, 73
   Find and Replace. See Find and Replace
   Bookmarks
   Overview, 72
   Sort, 96
   Toolbar and menu, 73
Build Bookmarks
   Create, 88
   Import and export, 89
   Selection properties, 89
   Text masking, 92

C
Compression Methods, 156
Content Assembly
   Merge. See Merge
   Overview, 54
   Split. See Split
   Toolbar and menu, 55
Customized Toolbar Button
   Commands. See Tool Commands
   Create, 21
   Delete, 23
   Edit, 21
   Enable and disable, 22
   Image, 22
   Import and export, 24
   Menu text, 21
   Name, 21
   Reorder, 25
   Show and hide, 22
   Tooltip, 21

E
Enfocus Certified, 175

F
FAQ. See Frequently Asked Questions
Find and Replace Bookmarks
   Find options, 85
   Replace options, 85
   Text masking, 86
Forum, 195
Frequently Asked Questions, 190

I
Images
   Menu, 159
   Overview, 153
   Preferences, 155
| CONTENTS | INDEX |

**Selection Tool**, 159  
**Tool button**, 154  
**Install**, 8

**K**

**Known Issues**, 195

**L**

**Layers**  
Create, 181, 188  
Menu, 178  
Overview, 176  
Preferences, 178  
Properties, 186  
Toolbar, 178  
**Link Checking**  
Show dead links on next page, 123  
Show dead links on this page, 123  
Show first dead link, 123  
**Link Management**  
Delete links, 140  
Find and replace filenames, 127  
Set base URL, 130  
Show/hide alignment palette, 124  
**Links**  
Batch processing, 40  
Checking. See Link Checking  
Customized toolbar button, 32  
Management. See Link Management  
Overview, 121  
Paste multiple links, 152  
Preferences, 148  
Reporting. See Reporting  
Toolbar and menu, 122

**P**

**Page Marks**  
Add, 58  
Edit, 60  
Export, 61  
Import, 61  
Remove, 59  
View, 60  
**Productivity**  
Overview, 12  
Preferences, 45  
Tool Manager, 19  
Toolbar Manager, 14

**R**

**Register**, 10  
**Reporting**  
All links, 143  
Bad actions, 141  
Bad bookmarks, 142  
Count links, 147  
External dependencies, 144  
Selected link or annot, 145

**S**

**Sequence**  
Create, 35  
Execute, 37  
**Split**  
Batch processing, 39  
By bookmarks, 62  
By page marks. See Page Marks  
By page range, 63  
Customized toolbar button, 33  
Destination, 66  
Into pages, 57  
Options, 65  

**M**

**Macintosh**  
Install, 8, 9  
System requirements, 8  
Uninstall, 10  
**Maintenance**, 196  
**Merge**
Overview, 56

Stamp
- Batch processing, 40
- Create profile, 104
- Create stamp, 104
- Customized toolbar button, 33
- Designing Stamps, 107, 111, 116
- Features, 99
- Logging, 118
- Overview, 98
- Preferences, 120
- Stamp document, 102
- Toolbar and menu, 101
- Type. See Stamp Type
- Undo, 102

Stamp Type
- Bates number, 113
- Dynamic text stamp, 112
- Image, 116
- Page number, 115
- PDF, 116
- Text stamp, 111

Support. See Technical Support
System requirements, 8

T

Technical Support, 197
Tool. See Customized Toolbar Button
Tool Commands
- Batch sequence execute, 28
- Bookmark, 31
- Link, 32
- Menu item execute, 27

Open file, 26
Select toolbutton, 30
Split, 33
Stamp, 33
World Wide Web link, 29

Toolbar
- Create, 15
- Delete, 15
- Import and export, 17
- Rename, 15
- Sample, 46
- Show and hide, 17

Toolbar Button
- Copy, 16
- Move, 16
- Remove, 17

Troubleshooting, 190

U

Uninstall, 10
Updates, 196

W

Watched Folders, 42
- Create, 42
- Log File, 44
- Running, 44

Windows
- Install, 9
- System requirements, 8
- Uninstall, 12